Automated Drawing

DataCAD includes several macros in the Macros pull-down menu that automate drawing polylines, walls, windows, elevators, and stairs as well as inserting furniture, plumbing, mechanical, and electrical symbols. EZ Tools helps you draw interior and exterior elevations quickly by automatically doing the calculations and line work necessary to draw the elevation. There are even utilities to help you recover corrupt drawing files or extract material take-offs from your drawing.

In this chapter:
- Automating building design
- Inserting door and window labels
- Exploding symbols
- Using the elevation and section tool
- Converting lines to walls
- Freeing excess memory in your drawing files
- Recovering corrupted drawing layers
- Advanced cut, copy, and clip function
**DataCAD AEC**

DataCAD AEC is a powerful DataCAD macro that runs a series of tools strategically designed to coordinate and automate building design. The GoToView, Layers, and DCAD3D options at the bottom of the menu are shortcuts to the 2D go-to-views, layers, and 3D Edit menus, respectively. To use DataCAD AEC, choose DCAD_AEC from the Toolbox menu.

**Drawing Sheet Borders**

Use the DwgSheet tool to place a drawing sheet border on your screen. This gives you an idea of how large an area you have in which to draw, given a certain plotting scale and paper size. To place a drawing sheet border on screen, choose DwgSheet from the DCAD_AEC menu, and set the DwgSheet options as described below.

The Scale and PaperSiz settings in the DwgSheet menu are used to calculate the size of the border sheet that is inserted into your drawing.

1. Choose Scale from the DwgSheet menu.
2. Choose a scale from the Scale menu. You can also edit the scale value list by adding, changing, or deleting scale values.

3. Type the available plotting width of your paper in feet and inches and press **Enter**.
4. Type the available plotting height of your paper in feet and inches and press **Enter**.

Use TitleLoc to specify the sheet location of the drawing sheet title block. You can locate the title block on the top, bottom, left, or right side of the drawing sheet. Choosing None inserts a drawing sheet without a title block.
To specify the number of boxes you want the title block to contain:

1. Choose TitleDiv from the DwgSheet menu. A list of values appears.
2. Type the number of divisions running across the title block and press Enter. (Choosing one title block division across and down creates a blank title block.)
3. Type the number of divisions running down the title block and press Enter. The divisions are drawn within the title block.

To set the height of the title block in feet and inches:

1. Choose TitleSiz from the DwgSheet menu. A list of values appears.
2. Choose or type a height and press Enter.

To specify the number of detail blocks you want your drawing sheet to contain:

1. Choose DtailDiv from the DwgSheet menu. A list of values appears.
2. Type the number of detail block divisions running across the drawing sheet and press Enter. (Choosing one detail block division across and down creates a drawing sheet without detail blocks.)
3. Type the number of detail block divisions running down the drawing sheet and press Enter.

Use DtailTtl to set the height of the detail block title box in feet and inches. When you choose DtailTtl, a list of values appears; choose or type a value and press Enter.

Use AddSnap to enter a snapping point at the center of your sheet border when it is inserted. When AddSnap is off, no snapping point appears.

Use DwgSymb to quickly access the Template menu in order to use the Drawing Symbols template to add common architectural symbols to your drawing. See “Templates and Symbols” in the “Drawing Elements” chapter for complete information.
Columns

Use Columns in the DCAD_AEC menu to create single or multiple, straight or curved rows of columns. The columns are drawn with their attendant column grid lines, and the lines are finished at one or both ends with circular labels denoting the column gridlines. DataCAD automatically separates the parts of this assembly to three user-defined layers as you draw columns.

1. Choose Columns from the DCAD_AEC menu.

2. Choose the following Columns options:

   - OneColum: Adds a single column symbol to the drawing through accessing the template dialog box; see “Templates and Symbols” in the “Drawing Elements” chapter for information on placing symbols
   - RectGrid: Creates a rectangular grid of columns
   - RadlGrid: Creates a radial grid of columns

Drawing Rectangular Grids

To create a rectangular grids of columns, change the RectGrid options described below as necessary. Select a point to start the grid, and DataCAD draws the grid.

You can set the number of rows of columns and column grid lines to draw in both the X and Y directions. When Column grid rotation is set to 90°, the X direction is vertical and the Y direction is horizontal. When you choose XRows or YRows, a list of values appears; choose or type the number of rows you want and press Enter.

You can set the distance between rows of columns in both the X and Y directions. When you choose XSpcg or YSpcg, a list of values appears; choose or type a distance value and press Enter.

SymbName sets the name of the symbol file containing the column symbol you want. The symbol is automatically inserted when the grid is created.

Numbring sets the direction in which grid label letters and numbers ascend. For example, if the toggle Lft2Rht is on in the RectGrid/Numbring menu, numbers written inside labels going across the drawing increase left to right (1, 2, 3 ...); otherwise, they increase right to left (... 3, 2, 1).

When the toggle Top2Bot is on in the RectGrid/Numbring menu, letters written inside labels going down the drawing increase top to bottom (A, B, C ...); otherwise, they increase bottom to top (... C, B, A).

Normally, column grids are labeled horizontally using numbers and vertically using letters. To create a column grid that is labeled horizontally with letters and vertically with numbers, use Rotation to rotate the column grid 90° before entering it.
Controls adds grid center line extensions past the end of the column grid, and specify where to add grid labels (1, 2, 3, or A, B, C). You can add centerline extensions and grid labels at the top, bottom, left, or right side of the grid, by toggling on the pieces you want drawn.

**GridLbl**  Draws grid labels for the top, bottom, left, or right rows

**ExtLine**  Draws extension lines for the top, bottom, left, and right rows. When you toggle ExtLine off, or grid centerline extension, on the top side of the grid, the top grid labels are automatically toggled off, since there is no extension to which to connect them.

Rotation rotates all the pieces of the column grid to any orientation. You can rotate the column grid itself by choosing ColmGrid and entering an angle of rotation. You can also rotate the columns relative to the grid rotation by choosing Columns and entering an angle of rotation. For example, if you set ColmGrid rotation to 30° and Rotation to 20°, the column is rotated 50° off horizontal. Rotate the text to match the angle of the column grid by toggling Text on; otherwise, text appears horizontally. You cannot specify a text rotation angle.

Layers specifies the layers on which to draw the column grid centerlines. You can select a different layer for each piece of the column grid. If you do not specify layers, the entire column grid is added to the active layer. Use GridLayr to type the name of the destination layer for the grid. Use SymLayr to type the name of the destination layer for the grid symbol.

Colors specifies a different color for the column grids. You can specify a different color for each piece of the column grid. If you don’t specify colors, the entire column grid is drawn in the color displayed in the Status Area. See “Color Menu” in “The Drawing Board” chapter for more information about how to choose a color. Color menu options include:

**GridColr**  Specifies a different color for centerlines

**SymColor**  Specifies a new color for the grid label symbols

**ChrColor**  Specifies a different color for grid label characters such as 1, 2, 3 or A, B, C

**ColLayr**  Type the name of the destination layer for the columns

LnFactor changes the spacing within the linetype you use to create the grid centerlines. For example, if you use a Centerlin linetype and have LnFactor set to 8, the short dashes of the centerline are drawn every eight feet when the grid is drawn. When you choose LnFactor, a list of values appears; choose or type a spacing value and press [Enter].
LnExtensn is the distance that the column grid centerlines are extended past the last column. Frequently you will want to extend the grid center lines a certain distance from the building in order to add grid labels (1, 2, 3, or A, B, C) which do not overlap the exterior wall of the building. Enter LnExtensn in current distance. When you choose LnExtensn, a list of values appears; choose or type an extension value and press Enter.

LblOffst sets the length of the “tail” on the circle that contains the grid symbols (1, 2, 3 or A, B, C). The distance from the centerline of the outermost building column to the inner edge of that circle is the LnExtensn distance plus the LblOffst distance. LblOffst is entered in current distance units. When you choose LblOffst, a list of values appears; choose or type an offset value and press Enter.

CharSize sets the size of the text characters (1, 2, 3 or A, B, C) which are inserted into the grid symbol circles. CharSize is entered in current distance units. For example, when you plot at 1/8” = 1’ scale and enter text characters which plot 1/4” high on the sheet of paper, set CharSize to 2 feet. When you choose CharSize, a list of text sizes appears; choose or type a text size and press Enter.

CharName specifies the starting number for the vertical columns and the starting letter for horizontal columns. This is useful when you construct a composite grid in which the first columns is not necessarily 1 or A. To reverse this, set the column grid rotation to 90° before entering the starting point of the grid.

When you choose CharName, a list of vertical or horizontal columns appears. Choose or type the starting vertical or horizontal column and press Enter. Vertical columns are always numbered, while horizontal rows of columns are always lettered.

CharFont sets the font name for the grid symbol text characters. You can specify a font that is different from the DataCAD text font, and both fonts will be used in the same drawing. Choose CharFont from the RectGrid menu, and then choose a font name from the list.

**Drawing Radial Grids**

RadlGrid creates a radial (circular) grid of columns. To draw a radial grid of columns, change the RadlGrid options described below necessary. Select the grid origin and then the point to draw the first column. Select the orientation of the last radial row, and DataCAD draws the grid.

CurvRows sets the number of columns and column grid lines to draw concentrically around the grid center. When you choose CurvRows, a list of values appears; choose or type the number of columns and grid lines to draw concentrically and press Enter.
RadlRows sets the number of columns and column grid lines to draw radially outward from the grid center. When you choose RadlRows, a list of values appears; choose or type the number of columns and grid lines to draw radially and press [Enter].

CurvSpcg sets the distance between columns drawn concentrically around the grid center. When you choose CurvSpcg, a list of spacing values appears; choose or type a spacing distance and press [Enter].

SepAngl sets the separation angle between any two columns drawn outward from the grid center; otherwise, the separation angle between the radial rows is calculated automatically by Fill. When you toggle SepAngl on, a list of separation angles appears; choose or type a separation angle and press [Enter]. SepAngl is only available when Fill is toggled off.

IncAngl sets the total included angle between the first and last columns drawn outward from the grid center. When you toggle IncAngl on, a list of included angles appears. Choose or type an included angle and press [Enter]. When IncAngl is off, enter the included angle by selecting two locations. IncAngl is only available when Fill is toggled on.

Fill sets the method for specifying the angle between rows and columns drawn outward from the grid center. When Fill is off, specify the individual angle between any two radial rows (SepAngl). When Fill is on, specify the total angle between the first and last radial row (IncAngl).

SymbName sets the name of the symbol file containing the column symbol. Choose SymbName, and select the name of the symbol you want to use. It is automatically inserted when the grid is created.

Label Numbering (Numbring) sets the direction in which letters and characters contained in grid labels ascend. For example, when Clkwse is on in the RadlGrid menu, numbers written inside labels going around the column grid center increase in a clockwise direction; otherwise, they increase in a counterclockwise direction.

The Controls setting indicates whether to add grid center line extensions past the end of the column grid, at what location(s), and whether to draw the columns at the first or last radial rows. You can add centerline extensions, grid labels, and columns at the first row and/or the last row by toggling on the pieces you want drawn.
Because there is no extension to which they can be connected, the first row grid labels are automatically turned off when you toggle ExtLine off on the first row. Likewise, both the extension line and the grid label for the first row are turned off when you toggle Columns off for the first row. Control options include:

- **GridLbl**: Draws grid labels for the first and last rows
- **ExtLine**: Draws grid line extensions for the first and last rows
- **Columns**: Draws column symbols for the first and last rows

Rotation rotates pieces of the column grid to any orientation. You can rotate the columns relative to the grid rotation by choosing Columns and entering an angle of rotation. You can rotate the text to match the angle of the column grid by toggling Text on; otherwise, text appears horizontally. You cannot specify a text rotation angle.

Layers specifies the layers on which to draw the column grid centerlines. Use GridLayr to specify the destination layer for the grid label characters (SymLayr) and the column symbols (ColLayr). You can specify a different layer for each piece of the column grid. When you don’t specify layers, the entire column grid is added to the active layer.

Colors specifies a different color for the column grid center lines (GridColr), the grid label symbol characters which are circles (SymColor), and the grid label characters (ChrColor). You can specify a different color for each piece of the column grid; otherwise, the entire column grid is added in the color displayed in the Status Area. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

LnFactor changes the spacing within the linetype you use to create the grid centerlines. For example, when you use a Centerlin linetype and have LnFactor set to 8, and the grid is drawn, the short dashes of the centerline are drawn every 8 feet (convenient for 8'-0" or 16'-0" column spacing). When you choose LnFactor, a list of values appears; choose or type a spacing value and press [Enter].

LnExtensn specifies the distance by which the column grid centerline is extended past the last column. Frequently, you will want to extend the grid center lines a certain distance from the building in order to add grid labels (1, 2, 3 or A, B, C) which do not overlap the exterior wall of the building. Enter LnExtensn in current distance units. When you choose LnExtensn, a list of values appears; choose or type an extension value and press [Enter].

LblOffst sets the label offset, or length of the “tail” on the circle containing the grid symbols (1, 2, 3 or A, B, C). The distance from the centerline of the outermost building column to the inner edge of that circle is the LnExtensn distance plus the LblOffst distance. Enter LblOffst in current distance units. When you choose LblOffst, a list of values appears; choose or type an offset value and press [Enter].
CharSize sets the size of the text characters. For example, if you are plotting at 1/8” = 1’ scale and you want to enter text characters which plot 1/4” high on the sheet of paper, set CharSize to 2 feet. (2 feet at 1/8” scale is 1/4”.) When you choose CharSize, a list of values appears. Choose or type a text size and press Enter.

CharName specifies the starting number for the vertical columns and the starting letter for the horizontal columns. This is useful when you constrict a composite grid in which the first columns are not necessarily 1 or A.

When you choose CharName, a list of starting vertical or horizontal columns appears. Choose or type the starting vertical or horizontal column and press Enter. Radial rows of columns are always numbered, while curved rows of columns are always lettered.

CharFont sets the font name, such as Original, Roman, or Helvetica, for the grid symbol text characters. You can specify a font that is different from the DataCAD text font, and both fonts are used in the same drawing. Choose a font name from the list.

**Walls**

The DCAD_AEC/Walls menu is similar to the Walls menu in Edit/Architect. The Walls option in the DataCAD AEC macro lets you draw two-line walls and automatically erase the intersecting wall segments at the corners, wall intersections, and T intersections. The Walls option searches for other walls or lines near the selected wall end points. For example, when the last wall of a simple rectangular room is located on or near the origin of the first wall, DataCAD automatically trims the intersecting wall lines.

For more information on drawing walls, polygons, and curves, refer to the “Drawing and Editing” chapter.

When editing walls, use the Cleanup options in the Edit menu to mend broken walls that were removed or erased and clean wall intersections.

1. Choose wall options to define the attributes of the wall, such as the highlight color and the wall width.
2. Choose Centers or Sides to define walls by the center of the walls or by the sides.
3. Toggle Clean on to trim the interior wall lines of T intersections as you enter lines. Be sure to enter line end points near the wall line that you want to trim, or DataCAD may trim the incorrect wall.
DataCAD only cleans intersections within the square area around the cursor called the Miss Distance. If the intersection does not clean, increase the miss distance using the Utility/Settings/MissDist option.

4. Toggle Cap on to insert a wall cap or closure between two open and parallel wall lines.

5. Indicate the start point of the wall.

6. Choose the other side of the wall, the inside or outside.

7. Indicate the end point of the wall.

8. Continue selecting wall end points.

9. Right-click to finish creating walls.

Use Hilite to draw walls with two different colors and/or two different line weights. When you choose Hilite the following options appear:

- **Color** Assigns a highlight color to the wall; see “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color
- **Width** Assigns a line weight to the wall; choose or type a line weight

➤ To modify the thickness of the walls:

1. Choose WallWdth from the menu. A list of wall thicknesses appears.

2. Choose a wall width or type a wall width and press [Enter].

**Cut Wall**

➤ To cut openings in walls by specifying two sides:

1. Choose CutWall from the menu. The following options appear:

   - **LyrSrch** Searches for walls on all layers
   - **Remove** Erases an opening that was created using CutWall; draw a rubberband box around the opening to remove, making sure that the rubberband box completely encloses the opening; DataCAD removes the opening and welds the walls

2. Select the first point on the wall where you want the opening.

3. Select the second point on the wall where you want the opening. DataCAD cuts the wall.
The Polygons and Curves options draw rectangles and curves, respectively, with a wall thickness. These menus match the Polygons and Curves menus in the Edit menu.

Windows

Windows in the DCAD_AEC menu lets you design and customize many types of windows for use in 2D production drawings. While these windows have some options for setting height variables, they are intended for use primarily in plan drawings. To construct realistic 3D models of windows, use the Windows menu in the AEC_Modl macro, also available in the Toolbox. See the “Automated Modeling” chapter for more information on AEC Model.

The following four options appear in many of the Windows submenus:

- **Color**
  - Color sets the color of the window mullions; see “Color Menus” in “The Drawing Board” chapter for more information.

- **LineType**
  - Sets the linetype of the window glass; choose a linetype from the list.

- **LineWdth**
  - LineWdth sets the line width of the window mullion. Make window mullion lines wider by increasing the value of LineWdth. When you choose LineWdth, a list of width values appears; choose or type a width and press (Enter).

- **LinSpcng**
  - LinSpcng sets the line spacing factor of the window mullions. For example, when the window mullions are drawn with dashed lines with a spacing of one inch, the dashes repeat every inch along each line of the window mullion. When you choose LinSpcng, a list of spacing values appears; choose or type a spacing and press (Enter).

HeadHght controls the header height of the window, while SillHght controls the sill height of the window. Choose or type a value and press [Enter]. See “Value Menus” in “The Drawing Board” chapter for more information.

With the Windows option, you can draw linear or curved bays of windows, or single windows. The OneWindw option takes you directly to the Windows menu in the Edit/Architct menu, where you can draw windows as described in the “Drawing and Editing” chapter. Drawing linear and curved bays of windows are explained below.
**Drawing Linear Window Bays**

The LinrWndw option in the Windows menu draws linear bays of windows.

Eq Bays calculates window walls with a set quantity of equally spaced bays. Eq Bays is mutually exclusive with FitBays and SetBays; only one of these options can be toggled on at any given time.

.general-bullet Check to draw multiple bays of windows:
1. Choose Eq Bays from the LinrWndw menu.
2. Select a starting point of the window wall.
3. Select the ending point of the window wall.
4. Choose a point on the outside of the wall. Eq Bays calculates the width of each window bay.

FitBays creates window walls with multiple bays of windows. The wall is filled with the maximum number of bays of a set size. FitBays is mutually exclusive with Eq Bays and SetBays; only one of these options can be toggled on at any given time.

.general-bullet Check to draw the maximum number of bays in a wall:
1. Choose FitBays from the LinrWndw menu.
2. Select a starting point of the window wall.
3. Select the ending point of the window wall.
4. Select a point on the outside of the wall. FitBays calculates the maximum number of bays that fit along the window wall and adds smaller bays at each end to fill out the overall window wall length.

Use SetBays to create bays of windows that have an opening length determined by a set bay quantity and size. SetBays is mutually exclusive with Eq Bays and FitBays; only one of these options can be toggled on at any given time.

.general-bullet Check to draw windows with a set bay quantity and size:
1. Choose SetBays from the LinrWndw menu.
2. Select the starting point of the individual bay size.
3. Type the number of bays that will make up the window wall.
4. Select the ending point of the individual bay size.
5. Select a point on the outside of the wall. SetBays calculates the overall window wall length.

Bay Qty lets you specify the number of window bays you want to draw. Bay Qty does not appear on the menu when FitBays is on because FitBays calculates the bay quantity automatically.

Use Bay Size to specify the width of the individual window bay, which is multiplied to create the window wall. Bay Size does not appear on the menu when Eq Bays is on because Eq Bays automatically calculates the individual bay size.

WallWdth sets the width of walls to draw and determines the depth of the window wall sills. When Cutout is on, the wall width is calculated automatically to determine the sill depth.

Use Cutout to calculate wall width for window insertion. Before the window is drawn, Cutout cuts a window opening into the wall. Cutout cuts the wall from top to bottom, which effects how the wall is viewed in 3DViews. Cutout is mutually exclusive with CntrLin and InnrEdg; only one of these options can be toggled on at any given time.

Use CntrLin to center the depth of the window wall along the two points you enter on the screen. When CntrLin is on, locate the starting and ending points of the window in the middle of the window wall. CntrLin is mutually exclusive with Cutout and InnrEdg; only one of these options can be toggled on at any given time.

Use InnrEdg to model the inside face of the window wall along the two points you enter on the screen. When InnrEdg is on, locate the starting and ending points of the window on the inner edge of the window wall. InnrEdg is mutually exclusive with CntrLin and Cutout; only one of these options can be toggled on at any given time.

You can draw windows by selecting the sides of the window opening or by selecting one side and the center of the window. Use By Ends to indicate the ends of the window wall by entering the two points on the screen. Use By Cent to indicate the center and one end of the window wall by selecting two points. By Ends and By Cent are mutually exclusive.
The Mullions menu includes the following options to customize the dimensions and location of the window mullions:

- **DoMulln**: Models window mullions; when DoMulln is off, windows are entered without mullions.
- **Width**: Sets the width of window mullions; the width is the mullion dimension in the direction along the face of the wall.
- **Depth**: Sets the depth of window mullions; the depth is the mullion dimension in the direction through the wall.
- **Offset**: Sets the distance from the inner edge of the wall to the inner edge of the mullion.
- **DoMarks**: Adds a snapping point to the center of each window mullion; when DoMarks is off, no center snapping point is added.
- **No Ends/HalfEnd/FullEnd**: Create a window wall with no mullions (No Ends), create mullions at the two ends drawn half as wide as the other mullions (HalfEnd), or create full-width mullions drawn at both ends (FullEnd).

The Glass menu includes the following options to customize dimensions and location of the glass:

- **DoGlass**: Models the glass lines.
- **Thickness**: Sets the thickness (the distance between the panes) of the glass; thickness has no effect when 1-Line is on.
- **Offset**: Sets the distance between the inner edge of the wall and the inside face of the glass.
- **1-Line/2-Line/3-Line**: Models glass as a single (1-Line), double (2-Line), or triple (3-Line) line between mullions.

The Sills menu includes options to customize the dimensions and location of the inner sill (or stoop) and the outer sill:

- **DoSill**: Models the window wall with windowsills.
- **Insill**: Defines the inner sill projection distance, the distance from the inner edge of the wall to the end of the inner sill.
- **Outsill**: Defines the outer sill projection distance, the distance from the outer edge of the wall to the end of the outer sill.
- **HeadDpth**: Sets the depth dimension of the window header.
- **SillDpth**: Sets the depth dimension of the windowsill.
**Drawing Curved Window Bays**

The CircWndw option in the Windows menu draws curved bays of windows.

Eq Bays calculates window walls with a set quantity of equally spaced bays. Eq Bays is mutually exclusive with FitBays and SetBays; only one of these options can be toggled on at any given time.

- To draw equally spaced bays of windows:
  1. Choose Eq Bays from the CircWndw menu.
  2. Select a starting point on the window wall.
  3. Select the ending point on the window wall.
  4. Choose a point on the outside of the wall. Eq Bays calculates the width of each window bay.

FitBays creates window walls with multiple bays of windows. The wall is filled with the maximum number of bays of a set size. FitBays is mutually exclusive with Eq Bays and SetBays; only one of these options can be toggled on at any given time.

- To draw the maximum number of bays in a wall:
  1. Choose FitBays from the CircWndw menu.
  2. Select a starting point on the window wall.
  3. Select an ending point on the window wall.
  4. Select a point on the outside of the wall. FitBays calculates the maximum number of bays that fit along the window wall and adds smaller bays at each end to fill out the overall window wall length.

Use SetBays to create bays of windows that have an opening length determined by a set bay quantity and size. SetBays is mutually exclusive with FitBays and Eq Bays; only one of these options can be toggled on at any given time.

- To draw windows with a set bay quantity and size:
  1. Choose SetBays from the CircWndw menu.
  2. Select the center point of the window wall arc.
  3. Type the number of bays that make up the window wall. SetBays calculates the overall window wall length.
4. Select the ending point of the individual bay size.

Use Bay Qty to specify the number of window bays you want to draw. Bay Qty does not appear on the menu when FitBays is on because FitBays calculates the bay quantity automatically.

Use BayAngle to specify the separation angle between individual window bays. This is multiplied to create the total curvature of the window wall. BayAngle does not appear on the menu when EqBays is on because EqBays automatically calculates the bay angle.

WallWdth sets the width of walls to draw and determines the depth of the window wall sills.

Use CntrLin to center the depth of the window wall along the two points you select. When CntrLin is on, locate your starting and ending points of the window in the middle of the window wall. CntrLin is mutually exclusive with InnrEdg; only one of these options can be toggled on at any given time.

Use InnrEdg to model the inside face of the window wall along the two points you select. When InnrEdg is on, locate your starting and ending points of the window on the inner edge of the window wall. CntrLin is mutually exclusive with InnrEdg; only one of these options can be toggled on at any given time.

Use Clckwse to model the window wall in a clockwise direction; otherwise the window wall is drawn in a counterclockwise direction.

Averagd only appears when FitBays is on. FitBays fits as many bays as possible of a specified separation angle into the opening you define. This usually leaves some space. When Averagd is on, the separation angle between the bays is slightly increased or decreased which causes each bay to slightly increase or decrease in width. The result is that the number of specified bays exactly fit into the defined opening because the leftover space has been averaged into the other bays. When Averagd is off, the leftover space at either end of the curved window wall is filled with bays of a smaller width.
The Mullions menu includes the following options to customize the dimensions and location of window mullions:

- **DoMulln**: Models window mullions; when DoMulln is off, windows are entered without mullions.
- **Width**: Sets the width of window mullions; the width is the mullion dimension in the direction along the face of the wall.
- **Depth**: Sets the depth of window mullions; the depth is the mullion dimension in the direction through the wall.
- **Offset**: Sets the distance from the inner edge of the wall to the inner edge of the mullion.
- **DoMarks**: Adds a snapping point in the center of each window mullion; when DoMarks is off, no center snapping point is added.
- **No Ends/HalfEnd/FullEnd**: Use these toggles to create a window wall with no mullions (No Ends), mullions at the two ends drawn half as wide as the other mullions (HalfEnd), or full-width mullions drawn at both ends (FullEnd).

The Glass menu includes the following options to customize dimensions and location of the glass:

- **DoGlass**: Models the glass lines.
- **Thickness**: Sets the thickness (the distance between the panes) of the glass; Thickness has no effect when 1-Line is on.
- **Offset**: Sets the distance between the inner edge of the wall and the inside face of the glass.
- **1-Line / 2-Line / 3-Line**: Models glass panes as a single (1-Line), double (2-Line), or triple (3-Line) line between mullions.

The Sills menu includes the following options to customize the dimensions and location of the inner sill (stoop) and the outer sill:

- **DoSill**: Models window sills.
- **InSill**: Defines the inner sill projection distance, the distance from the inner edge of the wall to the end of the inner sill.
- **OutSill**: Defines the outer sill projection distance, the distance from the outer edge of the wall to the end of the outer sill.
- **HeadDpth**: Sets the depth dimension of the window header.
- **SillDpth**: Sets the depth dimension of the window sill.
**Drawing Doors**

Selecting Doors from the DCAD_AEC menu takes you to the Edit/Architect/DoorSwng menu. See “Drawing Walls, Windows, and Doors” in the “Drawing and Editing” chapter for a description of the menu and its options.

**Drawing Elevators**

With Elevator you can draw single elevators or banks of elevators. Use this feature to completely customize the elevators, using standard or user-defined capacities, door type, location, and width.

1. Choose Elevator from the DCAD_AEC menu.
2. Set the Elevator menu options described below as necessary.
3. Select a front corner of the elevator bank.
4. Choose the direction of the elevator bank.
5. Select the back side of the elevator. The elevator bank is drawn.

Use Num Cab to set the number of elevator cabs you want to draw. Choose or type a value and press [Enter]. See “Value Menu” in “The Drawing Board” chapter for more information.

Use Capacity to set elevator dimensions. You can choose elevators with a standard capacity of 2000, 2500, 3000, 3500, or 4000 pounds. Choosing an elevator capacity from the displayed list makes the elevator’s dimensions match those found in the “Elevators” section of Architectural Graphic Standards. You can modify dimensions using the Cab, Walls, and Doors options of the Elevator menu.

The Cab menu sets all elevator dimensions related to the cab of the elevator and includes the following options:

- **ClearFrt**: Sets the clearance distance between the front of the elevator cab and the inside face of the elevator shaft wall
- **ClearBck**: Sets the clearance distance between the back of the elevator cab and the inside face of the elevator shaft wall
- **ClearLft**: Sets the clearance distance between the left side of the elevator cab and the inside face of the elevator shaft wall
- **ClearRht**: Sets the clearance distance between the right side of the elevator cab and the inside face of the elevator shaft wall
- **ClearBtw**: Sets the clearance distance between elevator cabs when the separating shaft wall between the cabs is not drawn
- **CabWidth**: Sets the width of the elevator cab
- **CabDepth**: Sets the depth of the elevator cab
Color  Sets the color of the elevator cab; see “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

When you choose any of the Cab options, a list of values appears representing clearance distances that are described with each option. Choose or type a clearance distance and press [Enter].

The Walls menu sets the dimensions and other variables for the elevator shaft walls which surround the cabs and includes the following:

- **Front**  Sets the width of the front wall of the elevator shaft
- **Back**  Sets the width of the back wall of the elevator shaft
- **Left**  Sets the width of the left wall of the elevator shaft
- **Right**  Sets the width of the right wall of the elevator shaft
- **Between**  Sets the width of the wall between elevator cabs
- **DrwBack**  Draws the outer edge of the back wall of the elevator shaft. When DrwBack is off, the outer edge of the back wall of the elevator shaft is not drawn, and the side walls of the elevator shaft are extended a distance equal to half the width of the back wall (in other words, drawn to the center line of the back wall). Toggling DrwBack off allows for easy creation of back-to-back elevators, since two halves of a back wall put together equal one party wall between back-to-back cabs.
- **DrwCntr**  Draws the shaft wall between elevators. This increases the center-to-center distance between elevators.
- **Color**  Sets the color of the elevator shaft walls; see “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.
The Doors option sets the dimensions, location, and types of elevator doors:

- **None/ Single/ Double/ Lap**
  - Draws the elevator without doors (None), with single doors (Single), with double doors (Double), or with overlapping doors (Lap)

- **AtFront**
  - Models doors of the specified type at the front of the elevator

- **AtBack**
  - Models doors of the specified type at the back side of the elevator

You can toggle on both AtFront and AtBack to create elevators with doors at both the front and back of the elevator.

- **Alternat**
  - Alternates overlapping doors between left panel outside and left panel inside, on every other elevator drawn. When the door is offset from the center of the cab (using Offset), Alternate causes the first elevator to have the door offset to the right, and the next elevator to have the door offset to the left, and so on. This creates the effect of grouping the elevators in pairs based on the proximity of their doors.

- **Width**
  - Sets the width of the elevator doors

- **Thickness**
  - Sets the thickness of the elevator doors

- **Offset**
  - Locates the elevator door off-center by specifying an offset distance. The offset distance is the distance along the front wall from the center of the cab to the center of the elevator door. An offset distance of 1'-0" centers the door 1'-0" to the right of the center of the cab, while an offset distance of -1'-0" centers the door 1'-0" to the left of the center of the cab.

- **Color**
  - Sets the color of the elevator door; see “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

Use ByFront in the Elevator menu to define the location of the elevator bank by locating two points along the outside face of the front elevator shaft wall. Conversely, use ByBack to define the location of the elevator bank by locating two points along the outside face of the back elevator shaft wall.

**Drawing Stairs**

Stairs creates double-run or single-run stairs. This Stairs tool is similar to the 3DStairs tool, but you can’t set as many options using Stairs.

1. Choose Stairs from the DCAD_AEC menu.
2. Choose the type of stair (UpAndDn, UpOnly, or DnOnly) and whether they will ascend on the left or right of the stair well.
3. Set the number of risers (NumRiser), the riser offset or distance from the railing to the first riser (Offset), the stair width including newel posts and stringers (StrWidth), the tread width (TrdWidth), and the nosing by choosing the option and entering a new value. See “Value Menus” in “The Drawing Board” chapter for more information on using these value menus.

4. Set the color that the stairs are drawn in by choosing Color from the Stairs menu and then choosing a color from the list. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

5. Set the railing, stair well, and section line options described below as necessary.

Choose Reset from the Stairs menu to return all settings in the Stairs menu to the default values.

6. Select the starting location of the stairs.

7. Select a point along the line of the stairs.

8. Select a point on the inside of the stair well. The stairs are drawn.

Use the Rails option in the Stairs menu to set railing options:

- DrwRail: Models railing
- Diameter: Sets the railing diameter
- Clearancx: Sets space between railing and wall, or the clearance from the wall
- RunOut: Sets railing runout, or the extension past the last tread
- Color: Sets railing color; see “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color

Use the StrWell option in the Stairs menu to set the stair well options:

- DrwWell: Models the stair well
- LandLnth: Sets the stair landing length
- ChseWdth: Sets the chase width, or the distance between stair wells
- Color: Sets the stair well color; see “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color

SectnLin sets the stair variables, such as gap width and line angle:

- GapWidth: Sets the width of gap between double section lines
- LinAngle: Sets the angle of the section lines
- LinColor: Sets the color of section lines; see “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color
- DashSpcg: Sets dashed line spacing
Adding Room Labels

With room labels you can locate positions on the drawing where you want room or equipment labels to appear. When you choose RmLabels from the DCAD_AEC menu, you are prompted to select the location where text will be inserted into the drawing. Because DataCAD remembers your last entry, you can easily enter the same room label in many different locations.

Set the following options in the RmLabels menu before entering text:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>Sizes and draws a box around text; box is mutually exclusive with Capsule or None; only one of these options can be toggled on at any given time</td>
</tr>
<tr>
<td>Capsule</td>
<td>Sizes and draws a rounded capsule around text; box is mutually exclusive with Capsule or None; only one of these options can be toggled on at any given time</td>
</tr>
<tr>
<td>None</td>
<td>Text appears with nothing around it; box is mutually exclusive with Capsule or None; only one of these options can be toggled on at any given time</td>
</tr>
<tr>
<td>TextSize</td>
<td>Sets the size of room label text. Text is entered in current distance units. For example, if you are plotting your drawing at 1/8”=1'-0&quot; and want room labels to appear at the height of ¼&quot; on your plotted drawing, set the Room Label text size to 2'-0&quot; (2.0). When you choose TextSize, a list of text sizes appears; choose or type a text size and press Enter.</td>
</tr>
<tr>
<td>TextAngl</td>
<td>Sets the angle at which the text and the box or capsule are drawn</td>
</tr>
<tr>
<td>Text Wgt</td>
<td>Sets the weight of room label text; entering a higher number for text weight results in thicker, heavier text</td>
</tr>
<tr>
<td>TextSlnt</td>
<td>Sets the slant of Room Label text, measured in degrees from vertical. A text slant of 0° produces a normal upright letter, while a text slant of 15° produces an italic letter</td>
</tr>
<tr>
<td>TextAspt</td>
<td>Sets the aspect of room label text. A text aspect of one produces a letter with normal text; a text aspect of two produces a tall, skinny letter; and an aspect of one half produces a short, wide letter.</td>
</tr>
<tr>
<td>TextFont</td>
<td>Sets the font for room label text, such as Original, Roman, or Helvetica. You can use multiple text fonts in the same drawing. Choose a font from the list.</td>
</tr>
<tr>
<td>AddSymb</td>
<td>Creates user-defined symbols, which are automatically entered next to room label text. For example, to insert text with a small box to the left of it, make a box and save it as a symbol in a DataCAD template file. Then, choose AddSymb and type the name of the symbol. Your symbol is automatically placed next to the text each time you insert a room label.</td>
</tr>
</tbody>
</table>
TextColr  Sets the color of Room Label text; see “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color

BrdrColr  Sets the color of the box or capsule that surrounds RmLabels text; see “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color

**Calculating Square Footage**

The SqFtCalc option creates geographical zones for different areas of a building. Once you have a geographical zone, you can create spaces within the zones. You can identify spaces as Non-rentable, Building Common, Floor Common, or Rentable. DataCAD can analyze these zones and spaces, producing two reports; one detailing the breakdown of spaces by type. The other analyzing the relative efficiency of the building design in relation to renting to single or multiple tenants.

Use the Add Zone option in the SqFtCalc menu to add new zones to a building. Once you create a zone, it becomes a menu option. You edit the zone or spaces within the zone by choosing the zone name from the menu.

⇒ To add a zone:

1. Choose Add Zone from the SqFtCalc menu.
2. Type in the name for the zone and press Enter.
3. Trace an outline to define the geographical limits of the zone.
4. Set the AddSpace, ZoneName, and Area options as described below.

⇒ To add new spaces to a zone you have defined:

1. Choose AddSpace from the Add Zone menu.
2. Type in a name for the space and press Enter.
3. Choose a space type:
   
   - **NonRent**  Non-rentable space
   - **BldgCom**  Common building areas
   - **Rentabl**  Rentable space
   - **FlrCom**  Common floor areas

4. Trace an outline that defines the geographical limits of the space.

Once you create a space, it becomes a menu option. You can edit it by choosing the name of the space from the menu.
To change the name of the zone you are currently editing:

1. Choose ZoneName from the Add Zone menu.
2. Type in a new name and press Enter.

Use Area to display the area of the zone or space you are editing on the screen. To print an area, run Report A or Report B.

**Generating Report A**

Report A generates a report detailing the relative renting efficiency of the building. It prints 132 characters wide. In order to see the entire report, use either awide-carriage printer or condensed type (17 characters per inch). See your printer instruction guide for more information.

1. Choose Report A from the SqFtCalc menu. Report A lists information under a series of headings as described below.
2. To print the report, choose To Prntr. To send the contents of the report to an ASCII text file, choose To File.

Floor lists all the zones by name.

*Gross Building Area* is the total square footage of the building, which is calculated by adding together the square footage of all defined zones.

*Non-Rentable Service* is the total square footage of all the spaces within the zone that have been identified as non-rentable service. Typical non-rentable service space includes stairs, elevators, and shafts.

*Building Common Service* is the total square footage of all the spaces within the zone that have been identified as Building Common Service. Typical Building Common Service space includes lobbies, locker rooms, and loading docks.

*Net Rentable Area* is the remaining building area after Non-rentable Service and Building Common Service areas are subtracted from the Gross Building Area. Net Rentable Area is computed as:

\[
\text{Net Rentable Area} = \text{Gross Building Area} - \text{Non-rentable Service} - \text{Building Common Service}
\]

*Gross Rentable Area* is the Building Common Service plus the Net Rentable Area in a building. The Gross Rentable Area is computed as:

\[
\text{Gross Rentable Area} = \text{Building Common Service} + \text{Net Rentable Area}
\]

*Common Area Factor* is the ratio of Gross Rentable Area in a building to the area rentable to tenants. The lower the Common Area Factor, the better the building design for rental purposes. The Common Area Factor is computed as:
Rentable Service is the total square footage of all the spaces within the zone that have been identified as Rentable Service. Typical Rentable Service spaces include toilets, telephones, and electrical and mechanical rooms.

Single Tenant Usable Area is the space tenants rent which is actually usable only by them. This applies only to tenants who occupy the entire floor of a building and do not have to share elevators, lobbies, or corridors with other tenants. Single Tenant Usable Area is calculated as:

\[
\frac{\text{Net Rentable Area}}{- \frac{\text{Rentable Service}}{\text{Single Tenant Usable Area}}}
\]

Single Tenant Factor calculates the rent efficiency of a particular area that a tenant is considering renting, assuming that this tenant is the only tenant occupying that floor of the building. A building with the lowest Single Tenant Factor gives the most space per rental dollar to the tenant. The Single Tenant Factor is calculated as:

\[
\frac{\text{Gross Rentable Area}}{- \frac{\text{Single Tenant Usable Area}}{\text{Floor Common Service}}}
\]

Floor Common Service is the total square footage of all the spaces within the zones that have been identified as Floor Common. Typical Floor Common Service spaces include elevator lobbies and public corridors.

Multiple Tenant Usable Area is the portion of space tenants rent that is actually usable only by them. This applies only to tenants who share a floor of a building and must, therefore, share elevators, lobbies, and/or corridors with other tenants. The Multiple Tenant Usable Area is calculated as:

\[
\frac{\text{Single Tenant Usable Area}}{- \frac{\text{Floor Common Service}}{\text{Multiple Tenant Usable Area}}}
\]

Multiple Tenant Factor calculates the rent efficiency of a particular building which a tenant is considering renting, assuming that this tenant shares the floor of the building with other tenants. A tenant will search for a building with the lowest Multiple Tenant Factor, to get the most space per dollar of rent. The Multiple Tenant Factor is calculated as:

\[
\frac{\text{Gross Rentable Area}}{- \frac{\text{Multiple Tenant Usable Area}}{\text{Multiple Tenant Usable Area}}}
\]
**Generating Report B**

Report B summarizes the square footage of all spaces in the building by grouping spaces according to the following four types: Non-rentable Service, Building Common Service, Rentable Service, and Floor Common Service. Each of these is described above in “Generating Report A”.

Report B prints 132 characters wide. To see the entire report, use either a wide-carriage printer or condensed type (17 characters per inch). See your printer manual for more information.

1. Choose Report B from the SqFtCalc menu.

2. To print the report, choose To Prntr. To send the contents of the report to an ASCII text file, choose To File.

**Adding Symbols**

You can add furniture, plumbing, mechanical, and electrical symbols from the DCAD_AEC menu. When you choose Furnitur or Mechanic, the Open Template dialog box appears. Choose a template to open, and then choose a furniture or mechanical symbol to place. See “Templates and Symbols” in the “Drawing Elements” chapter for more information about opening templates and placing symbols.

With the Plumbing tool, you can insert DataCAD plumbing symbols into your drawing and design lines of multiple plumbing fixtures and toilet partitions.

To insert plumbing symbols:

1. Choose Plumbing from the DCAD_AEC menu.

2. Select the starting and ending points of the wall that will contain plumbing fixtures. Choose the side of the wall upon which you want to place the fixtures. You must enter a line of plumbing fixtures before any of the following options appear.

3. Add fixtures to the plumbing wall (provided there is enough space on the wall), one at a time, by incrementing the number of handicapped stalls, stalls, urinals, and sinks using + and - toggles for each type of fixture. For example, to add three sinks, choose + Sink three times. To subtract a sink, choose - Sink once. The – toggles work only when the current number of fixtures is greater than zero. A running count of fixtures you select and any space remaining on the wall, based on the two points you entered, appears in the Message Window.
4. You can customize the dimensions and location of each type of fixture by using the HCStall, Stall, Urinal, and Sink menus. No fixtures are added to your drawing until you finish customizing the fixtures and specifying their quantities as described above.

5. To add the line of plumbing fixtures you selected to the drawing, choose Begin. DataCAD draws the number and type of fixtures you specified. DataCAD begins from the second point you entered and draws toward the first point you entered, adding HC stalls, stalls, urinals, and sinks in that order. You cannot customize the order in which fixtures are drawn.

PlumbSym is a shortcut to the Template menu; you can choose and insert plumbing fixture symbols into your drawing. See “Templates and Symbols” in the “Drawing Elements” chapter for more information about opening templates and placing symbols.

Use HC Stall to set all the variables for handicapped toilet stalls:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Sets the number of handicapped toilet stalls to draw</td>
</tr>
<tr>
<td>Length</td>
<td>Sets the length of the handicapped toilet stall; the length is the dimension from the wall behind the fixture to the inside of the partition containing the stall door</td>
</tr>
<tr>
<td>Width</td>
<td>Sets the width of the handicapped toilet stall; the width is the clear width inside the stall, from the left partition to the right partition</td>
</tr>
<tr>
<td>OpgWidth</td>
<td>Sets the width of the handicapped stall opening; if a door is drawn, OpgWidth also sets the width of the door</td>
</tr>
<tr>
<td>Doors</td>
<td>Models handicapped stall doors when the stall is drawn</td>
</tr>
<tr>
<td>HingeRt</td>
<td>Models handicapped stall doors with hinges on the right, based on a view from inside the stall; otherwise doors hinge on the left</td>
</tr>
<tr>
<td>SwingIn</td>
<td>Models handicapped stall doors that swing into the stall; otherwise doors swing outward</td>
</tr>
<tr>
<td>ToiltSym</td>
<td>Lists the fixture symbols for handicapped toilet stalls; choose a symbol from the list, or type a symbol name and press Enter</td>
</tr>
<tr>
<td>ResetDef</td>
<td>Resets only the handicapped stall variables to the DataCAD default values</td>
</tr>
</tbody>
</table>
### Use Stall to set toilet stall options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Sets the number of toilet stalls you want to draw</td>
</tr>
<tr>
<td>Length</td>
<td>Sets the length of toilet stalls; the length is the dimension from the wall behind the fixtures to the inside face of the partition containing the stall door</td>
</tr>
<tr>
<td>Width</td>
<td>Sets the width of toilet stalls; the width is the clear width inside the stall, from the left partition to the right partition</td>
</tr>
<tr>
<td>OpgWidth</td>
<td>Sets the width of the toilet stall opening; if a door is drawn, OpgWidth sets the width of the door</td>
</tr>
<tr>
<td>Doors</td>
<td>Models stall doors; otherwise openings are modeled, but not doors</td>
</tr>
<tr>
<td>HingeRt</td>
<td>Models stall doors with hinges on the right, based on a view from the inside of the stall; otherwise doors hinge on the left</td>
</tr>
<tr>
<td>SwingIn</td>
<td>Models stall doors that swing into the stall; otherwise doors swing out</td>
</tr>
<tr>
<td>ToiltSym</td>
<td>Lists fixture symbols to use as toilets for toilet stalls; choose or type a symbol name and press <strong>Enter</strong></td>
</tr>
<tr>
<td>ResetDef</td>
<td>Resets only the toilet stall variables to their default values</td>
</tr>
</tbody>
</table>

### Use Urinal to set all the variables for urinals:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Sets the number of urinals</td>
</tr>
<tr>
<td>Spacing</td>
<td>Sets the center-to-center spacing width of urinals. The spacing width is the center-to-center dimension between urinals. If there are no urinal partitions, the spacing width is the clear width inside the urinal stall from the left partition to the right partition.</td>
</tr>
<tr>
<td>Partitn</td>
<td>Models partitions between urinals</td>
</tr>
<tr>
<td>PrtnSize</td>
<td>Sets the length of the urinal partition from the wall out; PrtnSize only appears on the menu when Partitn is on</td>
</tr>
<tr>
<td>UrnlSym</td>
<td>Sets the fixture symbol to use as the urinal</td>
</tr>
<tr>
<td>ResetDef</td>
<td>Resets only the urinal variables to their default values</td>
</tr>
</tbody>
</table>
Use Sink to set all the variables for sinks:

- **Number**: Sets the number of sinks to model; choose or type a value and press Enter.
- **Spacing**: Sets the center-to-center dimension between sinks; you can temporarily override the spacing by toggling FitSinks on.
- **FitSinks**: Calculates the spacing between sinks, given whatever space remains on the wall; because FitSinks uses all remaining space on the wall, SpaceLeft always reads 0” when FitSinks is on, no matter how many fixtures are added or subtracted. When FitSinks is on, you can continue to add sinks, even until the actual sink symbols butt up against each other, but FitSinks does not allow sink symbols to overlap. When FitSinks is off, you determine sink spacing.
- **CodeMin**: Sets a minimum distance of 1’-6” between the center of the last sink and the inner edge of the end wall. When CodeMin is off, this distance is calculated as half the center-to-center sink spacing. There are no user-definable code minimums at this time.
- **SinkSym**: Selects the fixture symbol to use as the sink; choose or type a symbol name and press Enter.
- **ResetDef**: Resets the sink variables to their default values.

With the Electric option in the DCAD_AEC menu, you can insert single electrical symbols into a drawing and create ceiling or floor grids of any size and orientation, which automatically break the grid upon insertion. These grids are also useful for furniture plans, in which the furniture symbols break the grid upon insertion.

Choose Electric from the DCAD_AEC menu. If a template window is not already open, the following options appear:

- **ElecSymb**
- **CeilGrid**

If a template window is open when you choose Electric, the above options will not appear in the Menu Window. Choose NewFile from the Template menu to use these electrical templates.
To insert electrical symbols, one by one, into your drawing:

1. Choose ElecSymb from the Electric menu. If the template window is not already open, the following options appear:
   - Fl_Light: Fluorescent light
   - In_Light: Incandescent light
   - Rcptcl: Light receptacle
   - Signal: Miscellaneous outlets and specialty switches
   - Switch: Light switches

2. Choose the type of symbol you want to use.

3. Insert the symbol by pointing to it in the template window, dragging it into the drawing, and dropping it off at the correct location.

Use CeilGrid to define the boundaries of a ceiling grid, specify the grid’s size, rotation, and origin, and choose lighting fixtures to insert into a grid. To create a ceiling grid, choose CeilGrid from the Electric menu and set the ceiling grid options, as described below.

The Boundary menu defines the ceiling grid boundary:

- Select: Selects an existing boundary in the drawing to use as a ceiling grid boundary (a boundary can be any previously defined ceiling boundary or any polygon created in the 3DEntity menu whose plane is parallel to the floor)
- Create: Constructs a new boundary for the ceiling grid; enter up to 36 edges of the boundary; choose Close to complete the boundary
- Delete: Deletes any previously defined boundary or polygon
- SelSet: Every boundary you define becomes part of a selection set. (See “Editing Selection Sets” in the “Drawing and Editing” chapter for more information.) When you create a grid, DataCAD searches for all the boundaries belonging to a certain selection set and fills in the grid within or around those boundaries. You can define which selection set the boundary belongs to by choosing SelSet, then choosing a selection set from the list or typing the set number to use as a boundary and press [Enter].
- ShwBound: Makes all the boundaries in the current selection set blink for identification
- Clear SS: Disassociates the boundaries you defined from their selection set
Use Grids to define and locate the ceiling grid:

**X-Size**
Sets the size of the grid in the X direction; choose an X direction grid size from the list, or type a grid size and press Enter.

**Y-Size**
Sets the size of the grid in the Y direction; choose a Y direction grid size from the list, or type a grid size and press Enter.

**RotAngle**
Sets the rotation angle of the grid in degrees; choose or type a rotation angle and press Enter.

**DoBound**
Draws the ceiling grid boundary

**GridSS**
Like the boundaries, the grids which are automatically drawn become part of a selection set; choose GridSS to set which selection set you want the ceiling grid to belong to, then choose from set one through eight

**ShwGrid**
Makes all the grids in the current selection set blink for identification

**Append**
Creates one ceiling grid after another and appends them to the same selection set. When Append is off during creation of the second grid, the first grid is cleared from the grid selection set. Thus, insertion of light fixtures into overlapping grids causes only the second grid to break, for insertion of the fixture.

Use Fixtures to select and insert lighting fixture symbols that automatically break the ceiling grid:

**UseSymb**
Uses a symbol to represent a lighting fixture. When UseSymb is on, UsePoly is off, SymbName appears instead of PolySize, and the Color, LineType, LineWidth, and LinSpng menus do not appear because these attributes do not apply to symbols.

**UsePoly**
Uses a polygon to represent a lighting fixture. When UsePoly is on, UseSymb is off, and PolySize appears instead of SymbName.

**SymbName**
Lists the lighting fixture symbols to insert into the drawing; only appears on the menu when UseSymb is on. Choose or type a symbol name and press Enter.

**PolySize**
Sets the size of the lighting fixture polygon to insert into the drawing. This can be one of the standard sizes listed, or you can create your own size polygon by choosing CustRect (Custom Rectangular) or CustRnd (Custom Round). PolySize appears on the menu when UsePoly is on.

**RotAngle**
Sets the rotation angle of fixtures as they are inserted into a drawing. When you choose RotAngle, a list of rotation angle values appears. Choose or type an angle and press Enter.

**Cutout**
Cuts the ceiling grid for fixture insertion

**ByCorr**
Inserts the lighting fixture by its corner; when ByCorr is on, ByCentr is off
ByCentr

Inserts a lighting fixture by its center; when ByCentr is on, ByCorrn is off.

Grid SS

Like the boundaries, grids which are automatically drawn become part of a selection set. To determine which selection set you want the ceiling grid to belong to, choose Grid SS, then choose selection from set one through eight.

ShowGrid

Makes all the grids in the current selection set blink for identification.

ObjSnap

Determines object snapping points. This is the same ObjSnap menu as in the DataCAD Utility menu. For a detailed discussion of Object Snap, see “Object Snapping” in the “Drawing and Editing” chapter.

Z-Base enters the ceiling grid at the Z-base. Z-Hite enters the ceiling grid at the Z-height. See the “3D Viewing” chapter for more information.

The Cleanup option is a shortcut to the Cleanup menu in the Edit menu. See “Cleanup” in the “Drawing and Editing” chapter for more information.

Use Color to set the color for the ceiling grid. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

Use LineType to set the linetype for the ceiling grid. Choose LineType from the CeilGrid menu and choose a linetype from the list.

Use LineWidth to set the line width of the ceiling grid. When you choose LineWidth, a list of width values appears; choose or type a line width and press [Enter].

Use LinSpcng to set the line spacing factor of the ceiling grid lines. When you choose LinSpcng, a list of spacing values appears; choose or type a spacing factor and press [Enter].
Arrows

Arrows Arrow is a tool that lets you create open arrows of varying widths. Use Arrow to change the width of an existing arrow, erase the arrow, recreate it, and apply a new width.

1. Choose Arrow from the Toolbox menu.
2. Select the starting point for the arrow. The cursor is positioned at the center of the arrow line.
3. Select the ending point for the arrow. The arrow’s end point is the arrowhead’s point.
4. Continue adding arrows or choose Exit to return to the Toolbox menu.

➤ To change the width of the arrowhead and the arrow:
1. Choose Width from the Arrow menu. A list of values appears.
2. Choose or type a new arrow width value and press [Enter]. You return to the Arrow menu.
Door and Window Labels

Use the Door Label tool to create labels, or tags, for different types of doors and then to assign descriptive attributes to each label. This helps you to differentiate the doors in your drawing by categories such as size, material, or hardware. After you tag the doors in the drawing, use DoorLabl to produce door, material, and hardware schedules, as well as free-form reports.

To create a new door or window label:

1. Choose NewDoor from the DoorLabl menu or NewWndow from the WndwLabl menu.

2. Type the name of the tag you want to create and press Enter. If you are creating door labels, the message Unable to find symbol ‘door tag’. Do you wish to create it? appears; if you are creating window labels, the message Unable to find symbol ‘window tag’. Do you wish to create it? appears.

3. Choose Yes to create the tag. Choose No to return to the DoorLabl or WndwLabl menu.

4. Choose or type a text size value and press Enter.

5. Choose or type a door tag size factor and press Enter. The tag size factor is the ratio of the label symbol to the text; door label symbols are circles, and window label symbols are hexagons.

6. At the Mark prompt, type the name of the label as you want it to appear on the drawing or report and press Enter. You are prompted for a description of each of the following attributes:

   **Door Labels**
   - Door Width
   - Door Height
   - Door Thickness
   - Door Type
   - Frame Type
   - Door Material
   - Frame Material
   - Fire Rating
   - Head Detail No.
   - Jamb Detail No.
   - Sill Detail No.
   - Lockset Cat. No.
   - Exit Device Cat. No.
   - Door Closer Cat. No.
   - Kick Plate Cat. No.
   - Hinge Cat. No.
   - Remarks

   **Window Labels**
   - Window Width
   - Window Height
   - Window Thickness
   - Window Type
   - Head Detail No.
   - Jamb Detail No.
   - Sill Detail No.
   - Masonry Opening Width
   - Masonry Opening Height
   - Manufacturer
   - Model Number
   - Glazing
   - R Value
   - Remarks
7. Type a description or value for each attribute and press [Enter]. Each attribute is an optional entry. When an attribute is not valid for a particular label, leave the prompt blank and press [Enter]. Right-click to skip all remaining attributes.

After you enter attribute descriptions, you return to the tag list. The new label appears in the Menu Window.

8. To create another tag, return to step 2.

To position tags:

1. Choose NewDoor from the DoorLabl menu or NewWndow from the WndwLabl menu.
2. Choose the tag to place from the list.
3. Select the tag position by moving the cursor to the correct location in the drawing and clicking. You can continue to position the tag in this way.

To add or change tag attributes after you create the tag:

1. Choose EditFlds from the DoorLabl or WndwLabl menu.
2. Choose the tag you want to edit.
3. Choose the attribute you want to edit.
4. Type the new attribute description or value and press [Enter].
5. Choose Exit to return to the tag listing.

To produce a standard report:

1. Choose DataBase from the DoorLabl or WndwLabl menu.
2. For door labels, choose either Style1 for a Door Schedule report, Style2 for a Door and Hardware Schedule report, or Style3 for a Preliminary Hardware Schedule report. For window labels, choose either Style1 or Style2.
4. Choose the report destination:
   - ToScreen Sends the report information to the screen
   - ToPrintr Sends the report information to the printer
   - ToDwg Sends the report information to the drawing; adjust the text attributes and choose Exit
   - ToFile Sends the report information to a file; type a filename and press [Enter]
5. Choose Exit to return to the DataBase menu.

To produce a free-form report:
1. Choose DataBase from the DoorLabl or WndwLabl menu.
2. Choose FreeFrm from the DataBase menu.
3. Choose Sel Flds and choose the attributes you want to include in the report.
4. Choose Exit to return to the DataBase menu.
5. Choose FldWidth.
6. Choose the attribute to change.
7. Choose or type the report column width for this attribute.
8. Choose Exit to return to the attribute listing.
9. Choose another attribute or choose Exit to return to the DataBase menu.
10. Choose ShowQty to display the total quantity of each label in the drawing, as well as the grand total quantity of all the labels.
12. Choose the report destination. See the report destination descriptions above under the instructions for creating a standard report.
13. Choose Exit to return to the DataBase menu.
**EZ Tools**

EZ Tools allows you to parametrically draw residential or commercial interior and exterior elevations quickly and easily. These tools eliminate the need for the tedious linework and calculations previously required to create basic elevations. All angles, lines, offsets and line lengths are done automatically, leaving you free to concentrate on the drawing aesthetics.

The EZ Tools macro includes two tools, Elevations and Sections. The Elevations tool assists in the drawing of exterior residential elevations and also in creating door, window and cabinet elevations. The Sections tool is a quick way to create the outline section cut through cabinets, baths and showers.

---

To create elevations and sections using EZ Tools, you must select points in your drawing. You can use either your mouse or keyboard coordinate entry to select points. When using your mouse to select the points, press \( \text{Shift} + \text{O} \) to toggle Ortho mode on to constrain the base line to the X axis. Set the Ortho mode option to Off to draw the elevation at any angle. See “The Drawing Board” chapter for more information about using the mouse and coordinate entry.

---

**Elevations**

The Elevations tool assists in drawing exterior and interior residential elevations. This tool consists of four functions: Exterior, Door, Window, and Cabinet. To use the Elevations tool, choose EZ Tools from the Toolbox menu, and then choose Elev from the EZ Tools menu.

The Exterior function in the Elevations menu assists in drawing exterior elevations. You will define the exterior elevation by selecting two points along the line of the sub-floor. The exterior elevation will be drawn relative to those two points, based on the settings explained below.

For illustrations of the exterior elevation settings, please refer to the sample drawings, EXTELEV1.DC5 and EXTELEV2.DC5 in your DataCAD DWG\SAMPLES directory.

---

To create an exterior elevation:

1. Choose Exterior from the Elevation menu.
2. Choose Style from the Exterior menu and choose one of the available styles:
   
   - **Gable**: Gable roof style, available in Partial or Full
   - **Hip**: Hip roof style, available in Partial or Full
   - **Boston**: Boston roof style, available in Partial or Full
   - **Shed**: Shed roof style, available in Partial or Full
3. Choose Partial or Full to define a partial or full exterior elevation. Full exterior elevations are drawn from one wall to the opposite wall of the building on the other side of the ridge. Partial exterior elevations are drawn from one wall to an arbitrary point along the top surface of the sub-floor on one side of the ridge.

4. PlateHgt controls the height of the top plate on which the rafters rest. The default height is 8’-0” above the sub-floor plane. To change the plate height, choose PlateHgt, and then choose or type a height and press [Enter].

5. Pitch controls the rise of the roof for every one foot of run. The default rise is 6”. To change the roof pitch, choose Pitch, and then choose or type a distance and press [Enter].

6. RoofThck controls the width of the rafters and the position of the roof line. The roof line is drawn 1/2” from the top surface of the rafter. The default roof thickness is 9 1/2” and is relative to the plate height. When you choose RoofThck, a list of values appears; choose or type a value and press [Enter].

See sample drawing EXTELEV1.DC5 for a detailed illustration of this setting.

7. Overhang controls the length of the roof overhang. This dimension is measured from the wall exterior framing surface to the back surface of the fascia. The default roof overhang is 1’-0”. When you choose Overhang, a list of values appears; choose or type a value and press [Enter].

8. WallThck controls the thickness of the wall framing. The wall thickness is relative to the first point you select to define the exterior elevation. The default wall thickness is 3 1/2”. When you choose WallThck, a list of values appears; choose or type a value and press [Enter].

9. Fascia controls the fascia width. The fascia width is measured across the back surface of the fascia. The default fascia width is 7 1/2”. The fascia thickness is set at 3/4” and cannot be adjusted. When you choose Fascia, a list of width values appears; choose or type a value and press [Enter].

10. Rake Brd controls the width of the rake board. The rake board width is measured relative to the roof line. The default rake board width is 7 1/2”. When you choose Rake Brd, a list of values appears; choose or type a value and press [Enter].

11. CornrBrd controls the width of the corner board. The corner board is measured relative to the exterior wall line. The default corner board width is 5 1/2”. When you choose CornrBrd, a list of values appears; choose or type a value and press [Enter].
12. CladThck controls the thickness of the cladding. The cladding is measured from the wall framing out to the exterior wall line. The default cladding thickness is 1 1/2". When you choose CladThck, a list of values appears; choose or type a value and press [Enter].

13. GradElev controls the position of the grade line. The grade elevation is measured relative to the sub-floor. The default setting is 2’-0”. When you choose GradElev, a list of values appears; choose or type a value and press [Enter].

The distance between the top surface of the sub-floor and the bottom edge of the cladding is 1’-0” and cannot be adjusted. For best results, the grade elevation should be set to 1’-0” or greater. See sample drawing EXTELEV2.DC5 for a detailed illustration of this setting.

14. Choose Out Colr to set the outer color. The default color is white.

15. Choose In Colr to set the inner color. The default color is red.

16. Select the first point of the exterior elevation at the top surface of the sub-floor. This point will indicate the outside surface of the wall framing. Select the second point of the exterior elevation to the left or right along the plane of the sub-floor. The exterior elevation is drawn. Elevations are aligned with the two points that you select.

If you are drawing a full exterior elevation, the second point will indicate the opposite side of the building from the first point. If you are drawing a partial exterior elevation, the second point will be an arbitrary point along the top surface of the sub-floor on one side of the ridge.

You can choose Defaults at any time to reset all exterior elevation settings to the default values.
To draw a residential and commercial door elevation:

1. Choose Door from the Elevation menu.

2. Choose Style from the Door menu and choose one of the available door styles:
   - Flush: Flush style, available in Single or Double
   - HalfLght: Half Light style, available in Single or Double
   - Patio: Patio style, available in Single or Double
   - French: French style, available in Single or Double
   - Leaded: Leaded glass style, available in Single or Double
   - HalfLead: Half Leaded glass style, available in Single or Double
   - SixPanel: Six Panel style, available in Single or Double
   - Bifold: Bifold style, available in Single or Double
   - Accord: Accordion style, available in Single or Double
   - Vented: Vented style, available in Single or Double
   - NarLtRt: Narrow Light Right style, available in Single or Double
   - NarLtLft: Narrow Light Left style, available in Single or Double
   - StorFrnt: Storefront style, available in Single or Double
   - Garage A: Garage style, type A
   - Garage B: Garage style, type B
   - Sliding: Sliding glass door style

For examples of the door elevation styles, please refer to the sample drawing DORELEV1.DC5 in your DataCAD DWG\SAMPLES directory.

3. Choose Single or Double to define a single or double door. This option does not apply to the Garage A, Garage B, or Sliding styles.

4. Head Hgt controls the head height of the door. When you choose Head Hgt, a list of height values appears; choose or type a height and press [Enter].

5. Use Trim to toggle the trim option on or off. The width of the trim is automatically set to 2 1/2”. The Trim option cannot be toggled on if the SideLght option is on.

6. Use SideLght to toggle the sidelight option on or off. The style of the sidelight is automatically set. The SideLght option cannot be toggled on if the Trim option is on.

7. Use Stop to toggle the stop option on or off. The width of the stop is automatically set to 3/4”. The Stop option only appears when the Trim option or the SideLght option is toggled on.
For examples of the Trim, SideLght, and Stop door elevation settings, please refer to the sample drawing DORELEV2.DC5 in your DataCAD DWG\SAMPLES directory.

8. Choose TrimColr to set the trim color. The default color is white.

9. Choose DoorColr to set the door color. The default color is red.

10. Select the first point of the door width along the floor line. Select the second point of the door width to the left or right along the floor line. The door is drawn. Elevations are aligned with the two points that you select.

You can choose Defaults at any time to reset all door settings to the default values.

➤ To create a exterior and interior residential window elevation:

1. Choose Window from the Elevation menu

2. Choose Style from the Window menu and choose one of the available styles:

   - Picture: Picture style, available in Single or Double
   - Pict 4x8: Picture style with 4x8 divided lights, available in Single or Double
   - Pct3x6: Picture style with 3x6 divided lights, available in Single or Double
   - PictLead: Picture style with leaded glass, available in Single or Double
   - DH 1/1: Double hung style with no panes, available in Single or Double
   - DH 4/4: Double hung style with 4x4 panes, available in Single or Double
   - DH 6/6: Double hung style with 6x6 panes, available in Single or Double
   - DH 6/4: Double hung style with 6x4 panes, available in Single or Double
   - DH 9/6: Double hung style with 9x6 panes, available in Single or Double
   - CasemntA: Casement style, type A, available in Single or Double
   - CasemntB: Casement style, type B
   - CasemntC: Casement style, type C
   - CasemntD: Casement style, type D
   - CasemntE: Casement style, type E
   - HSliderA: Horizontal sliding style, type A
   - HSliderB: Horizontal sliding style, type B

   For examples of the window elevation styles, please refer to the sample drawing WINELEV1.DC5 in your DataCAD DWG\SAMPLES directory.

3. Choose Single or Double to define a single or double window. This option does not apply to all window styles.

4. Head Hgt controls the head height of the window. When you choose Head Hgt, a list of height values appears; choose or type a height and press Enter.
5. Sill Hgt controls the sill height of the window. When you choose Sill Hgt, a list of height values appears; choose or type a height and press Enter.

6. Choose BriksillA to toggle the brick sill (style A) option on or off. The BriksillA option cannot be toggled on if the BriksillB, Capstone, ShutterA, or ShutterB options are on.

---

For examples of the Briksill, Capstone, and Shutter window elevation settings, please refer to the sample drawing WINELEV2.DC5 in your DataCAD DWG/SAMPLES directory.

---

7. Choose BriksillB to toggle the brick sill (style B) option on or off. The BriksillB option cannot be toggled on if the BriksillA, Capstone, ShutterA, or ShutterB options are on.

8. Choose Capstone to toggle the capstone option on or off. The Capstone option cannot be toggled on if the BriksillA, BriksillB, ShutterA, or ShutterB options are on.

9. Choose ShutterA to toggle the shutter (style A) option on or off. The ShutterA option cannot be toggled on if the BriksillA, BriksillB, Capstone, or ShutterB options are on.

10. Choose ShutterB to toggle the shutter (style B) option on or off. The ShutterB option cannot be toggled on if the BriksillA, BriksillB, Capstone, or ShutterA options are on.

11. Choose FramColr to set the frame color. The default color is white.

12. Choose SashColr to set the sash color. The default color is red.

13. Select the first point of the window opening along the floor line. Select the second point of the window opening to the left or right along the floor line. The window is drawn. Elevations are aligned with the two points that you select.

You can choose Defaults at any time to reset all window settings to the default values.
To draw a cabinet elevation:

1. Choose Cabinet from the Elevation menu.

2. Choose Style from the Cabinet menu and choose one of the available styles:

   - Std Wall: Standard wall style, available in Single or Double
   - Std Base: Standard base style, available in Single or Double
   - Std Drwr: Standard drawer style, available in Single or Double
   - Std Sink: Standard sink style, available in Single or Double
   - Std Desk: Standard desk style, available in Single or Double
   - Van Base: Vanity wall style, available in Single or Double
   - Van Drwr: Vanity drawer style, available in Single or Double
   - Van Sink: Vanity sink style, available in Single or Double
   - HC Wall: Handicapped wall style, available in Single or Double
   - HC Base: Handicapped base style, available in Single or Double
   - HC Drwr: Handicapped drawer style, available in Single or Double
   - HC Sink: Handicapped sink style, available in Single or Double
   - HC Desk: Handicapped desk style, available in Single or Double
   - Pantry: Pantry style, available in Single or Double
   - Oven: Oven style, available in Single or Double

3. Choose Single or Double to define a single or double cabinet.

4. Wall Hgt controls the height of a standard wall cabinet. This option is only applied to the Std Wall cabinet style. When you choose Wall Hgt, a list of height values appears; choose or type a height and press Enter.

5. SplshHgt controls the height of the back splash. When you choose SplshHgt, a list of height values appears; choose or type a height and press Enter.

6. Choose Pull Rt to set the cabinet pull on the right.

7. Use Pull Lft to set the cabinet pull on the left. This option is only available on single cabinets.

8. Use Section to draw cabinet sections. For more information on cabinet sections, see “Sections” below.

9. Choose CntrColr to set the counter color. The default color is white.

10. Choose Cab Colr to set the cabinet color. The default color is red.

For examples of the cabinet elevation styles, please refer to the sample drawing CABELEV.DC5 in your DataCAD DWG/SAMPLES directory.
11. Select the first point of the cabinet opening along the floor line. Select the second point of the cabinet opening to the left or right along the floor line. The cabinet is drawn. Elevations are aligned with the two points that you select.

You can choose Defaults at any time to reset all cabinet settings to the default values.

---

If you are using the Std Wall cabinet type, the two points selected will indicate the top of the cabinet, not the bottom.

---

**Sections**

The Sections function gives you a quick way to create the outline section cut through cabinets, baths and showers. To use the Sections tool, choose EZ Tools from the Toolbox menu, and then choose Section from the EZ Tools menu.

➤ To create a cabinet section:

1. Choose Cabinet from the Section menu.

2. Choose one of the available styles:
   
   Standard    Standard style  
   HandiCap    Handicapped style  
   Vanity      Vanity style  
   PassThru    Pass through style  
   BarTop      Bar top style  
   Bathtub     Bathtub style  
   Shower      Shower style  

3. Soff Hgt controls the soffit height of the cabinet. When you choose Soff Hgt, a list of height values appears; choose or type a height and press [Enter].

4. WCab Elv controls the elevation of the wall cabinet. When you choose WCab Elv, a list of values appears; choose or type a value or use DataCAD’s online calculator and press [Enter].

5. WCab Hgt controls the height of the wall cabinet. When you choose WCab Hgt, a list of height values appears; choose or type a height and press [Enter].

6. SplshHgt controls the height of the back splash. When you choose SplshHgt, a list of height values appears; choose or type a height and press [Enter].

7. Choose Elev to open the cabinet elevation menu to draw cabinet elevations.
8. Choose SectColr to set the section color. The default color is white.

9. Choose ElemColr to set the element color. The default color is red.

10. Select the first point of the cabinet section along the floor line. Select the second point of the cabinet section to the left or right along the floor line. The cabinet section is drawn. Sections are aligned with the two points that you select.

You can choose Defaults at any time to reset all cabinet settings to the default values.
Clip It

Clip It is a drafting tool you can use to erase, move, or copy 2D line, 3D line, 2D arc, and circle entities. Clip It works only in orthographic (plan) view. If you are in another view such as oblique, DataCAD automatically changes to orthographic view when you use Clip It. When you exit Clip It, DataCAD returns you to your original view.

Clip It has three important features that distinguish it from the standard DataCAD editing commands: Clip, Cut, and Copy.

When you draw a boundary using Clip It, you can select entities on either side of the boundary. In this way, the boundary separates an area from the rest of the drawing and then lets you select entities either inside or outside.

Selecting entities inside the boundary is clipping, while selecting entities outside the boundary is cropping. The boundary can have an irregular shape. It can also slice through multiple layers which helps you clip and crop entities on different layers of your drawing.

Clip It can also erase or copy parts of entities. Normally an entity must be completely enclosed by a boundary when you select an entity using an Area boundary. Partial erase is available but time-consuming to use when you have many entities to select. Using Clip It, you can break entities at the borders of the boundary and use only the parts of the entities that you need.

There is one important point to remember about Clip It. You can clip or crop from any or all layers of your drawing, but you can only copy to a single layer. You can change the layer and copy to any location in the drawing, but each copy appears on only one layer.

Clip It is especially useful for editing hatched areas in elevation drawings or for copying portions of a drawing.

Take note of the following performance hints:

- In general, Clip It processes most quickly when the boundary is a rectangle or a polygon with three or four sides. A circular boundary will process more slowly, and a polygonal boundary with more than four sides will have the slowest processing time.

- Before selecting LyrSrch, toggle off all the layers that you don’t want to process. This reduces the number of entities Clip It checks against the boundary.
1. Choose ClipIt from the Toolbox menu. The following options appear:

- **Area**: Uses a rectangle as the boundary for clipping and cropping
- **Fence**: Uses a polygon as the boundary for clipping or cropping; the polygon can have up to 36 vertices and can be concave or convex, but its lines cannot cross
- **RadCirc**: Uses a circle defined by its radius as the boundary for clipping and cropping
- **DiaCirc**: Uses a circle defined by its diameter as the boundary for clipping and cropping
- **Boundry**: Adds an outline of the boundary area to the drawing; the boundary outline uses active layer settings for such attributes as color and linetype
- **LyrSrch**: Searches all active layers for entities to clip or crop; toggle LyrSrch off to clip or crop entities on the active layer only (see the “Selection Menu” section in “The Drawing Board” chapter for more information)
- **Cut**: Erases clipped or cropped entities from the drawing
- **CutCopy**: Moves clipped or cropped entities to other locations in the drawing and erases the original entities
- **Copy**: Copies clipped or cropped entities to another location in the drawing, leaving the originals intact
- **Clip**: Processes entities inside the ClipIt boundary
- **Crop**: Processes entities outside the ClipIt boundary
- **2D Line**: Includes 2D line entities in the clipping or cropping process
- **3D Line**: Includes 3D line entities in the clipping or cropping process
- **2D Arc**: Includes 2D arc entities in the clipping or cropping process
- **Circle**: Includes circle entities in the clipping or cropping process
- **Layers**: Accesses the DataCAD Layers menu; use to choose layers to include in ClipIt processing, change the active layer, or add a new layer (see “Layers” in the “Before You Draw” chapter for more information)

2. Choose a boundary type: Area, Fence, RadCirc, or DiaCirc.
3. Choose to cut, cut and copy, or copy the entities.
4. Select entities inside (clip) or outside (crop) the boundary.
Clipping and Cropping

5. Choose the entity type(s) you want to edit: 2D Line, 3D Line, 2D Arc, or Circle. You can select one or more entity types for editing.

6. Toggle LyrSrch on to edit entities on multiple layers. Toggle LyrSrch off to edit only the active layer.

7. Choose Boundry to add an outline to the boundary.

8. During processing, the Message Window displays the percentage of entities you clip or crop; this is not the percentage of processing time. When processing is complete, the total calculation time appears in the Message Window.

9. You can use Undo to reverse the last ClipIt process, but you must use it before you exit ClipIt.

10. Choose Exit to close the ClipIt macro. Always use the Exit command to close ClipIt; otherwise the undo buffer won’t be cleared reducing the memory available for your drawing files and potentially causing errors when you run DataCAD.

The entities that result from clipping and cropping retain such attributes as linetype and line color. For 2D lines, 2D arcs, and circles, Z-base and Z-height remain the same. For 3D lines, ClipIt recalculates Z values for the new end points based on the slope of the line.
Be careful using DataCAD shortcuts while using Clip It. Some shortcuts exit the tools and take you to other menus. If you use those shortcuts while you’re in Clip It, you won’t be able to use the Undo feature to restore your drawing. For instance, don’t exit ClipIt by pressing 

To erase clipped or cropped entities specified by a boundary:

1. Choose Cut from the ClipIt menu to erase the selected entities from the drawing.
2. Choose Area, Fence, RadCirc, or DiaCirc as the boundary type.
3. Choose Boundary to add an outline of the boundary to the drawing. ClipIt adds the outline to the active layer only and uses active layer settings for attributes like color and linetype.
4. Choose 2D Line, 3D Line, 2D Arc, or Circle as the entity type(s) to cut.
5. To cut entities on multiple layers, choose Layers and toggle on the layers you want to process. Toggle LyrSrch on to clip or crop entities on all layers that are toggled on.
6. Draw the boundary area on the screen, following the prompts in the Message Window. Clipping or cropping begins when the boundary is complete. If part of an entity crosses over the boundary line, the system clips or crops it at the boundary and cuts the remaining section.
7. To stop clipping or cropping and return the entities to their previous state, press [Delete] or [End]. To restore a drawing to its previous state after the entities are cut, choose Undo.
8. Choose Exit to return to the ClipIt menu.

Always use the Exit command to close ClipIt; otherwise the undo buffer won’t be cleared reducing the memory available for your drawing files and potentially causing errors when you run DataCAD.

To cut and copy entities:

1. Choose CutCopy from the ClipIt menu to cut the entities and copy them to another location.
2. Choose Area, Fence, RadCirc, or DiaCirc as the boundary type.
3. Choose Boundry to add an outline of the boundary to the drawing. The outline uses the active layer settings for attributes like color and linetype.
4. Choose 2D Line, 3D Line, 2D Arc, or Circle as the entity type(s) you want to cut and copy.
5. To cut entities on multiple layers, select Layers and toggle on the layers you want to process. Toggle LyrSrch on to clip or crop entities on all the layers that are on.

6. Draw the boundary area on the screen, following the prompts in the Message Window. Clipping or cropping begins when the boundary is complete. If part of an entity crosses the boundary line, the system clips or crops it at the boundary and cuts the remaining section.

7. To stop the clipping or cropping process and return the entities to their previous state, press \[Delete\] or \[End\]. To return the entities to their previous state after the clipping or cropping process is complete, select Undo.

8. Select the point to drag the entities from. This drag point indicates the beginning of the distance you want to move or copy.

9. Choose Boundry to add an outline of the boundary to the drawing.

10. Choose the new location for the entity using one of the methods described in the “Locating Copies” sections below.

11. When you finish copying entities, choose Exit to return to the ClipIt menu. To restore the drawing to its previous state, choose Undo.

Always use the Exit command to close ClipIt; otherwise the undo buffer won’t be cleared reducing the memory available for your drawing files and potentially causing errors when you run DataCAD.

To copy clipped or cropped entities to another location in the drawing, leaving the original entities intact:

1. Choose Copy from the ClipIt menu to copy entities to another location.

2. Choose Area, Fence, RadCirc, or DiaCirc as the boundary type.

3. Choose Boundry to add an outline of the boundary to the drawing. The outline uses the active layer settings for attributes like color and linetype.

4. Choose 2D Line, 3D Line, 2D Arc, or Circle as the entity type(s) you want to copy.

5. To clip or crop entities on multiple layers select Layers and toggle on the layers you want to process. Toggle LyrSrch on to clip or crop entities on all the layers that are on.

6. Draw the boundary area on the screen, following the prompts in the Message Window. Clipping or cropping begins when the boundary is complete. When part of an entity crosses the boundary, the system clips or crops it at the boundary and processes the remaining section.
7. To stop the clipping or cropping process and return the entities to their previous state, press [Delete] or [End]. To restore the entities to their previous state after the clipping or cropping process is complete, choose Undo.

8. Choose the point to drag the entity from. This point indicates the beginning of the distance you want to move or copy.

9. Choose Boundry to add an outline of the boundary to the drawing.

10. Choose the new location for the entity using one of the methods described in the “Locating Copies” sections below.

11. When you finish copying entities, select Exit to return to the ClipIt menu. To restore the drawing to its previous state, choose Undo.

Always use the Exit command to close ClipIt; otherwise the undo buffer won’t be cleared reducing the memory available for your drawing files and potentially causing errors when you run DataCAD.

Unlike Cut or CutCopy, Copy does not erase the entities specified by the original boundary.

<table>
<thead>
<tr>
<th></th>
<th>Before Clipping</th>
<th>Select area to Clip</th>
<th>After Clipping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CutCopy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Cut, CutCopy, and Copy
Locating Copies

You have a number of options for placing copies of the entities selected by ClipIt which are the same as those available using DataCAD editing commands. The following descriptions are divided into two categories: locating copies in the X,Y plane and locating copies on other layers.

There are several ways to position copies in the X, Y plane. You can use any of these together with options for locating copies on other layers. You can place a copy on another layer at the same time you locate it in the X, Y plane. These options are available after you select the drag point.

- Move the copy with the cursor and place it in the drawing by selecting or snapping to a point with the mouse.

- Press [Spacebar] and enter the relative distance and angle, or relative X and Y distances, from that point. When you use this method to make multiple copies, ClipIt locates each copy relative to the placement of the last when you use either relative polar or relative Cartesian coordinates.

- Press [‘] and select a reference point. The copy is positioned relative to this reference point. Next, press [Spacebar] and type a relative distance and angle, or relative X and Y distance, from the reference point and press [Enter]. To place multiple copies relative to the same reference point, indicate the reference point after each copy is placed.

You can place copies made with CutCopy and Copy on any new or existing layer in your drawing.

1. Choose Layers to create a new layer. Use the Layers menu as you normally would to create the new layer and assign its attributes. Choose Exit to return to ClipIt.

2. To place the copy on a layer other than the active layer, choose ToLayer. Choose the layer where you want to place the copy; the layer displays in the Status Area.

3. Place the copy at the new location on the layer using one of the methods describing how to locate copies in the X-Y plane.

To place the copy at the same X-Y coordinates as the original, but on a different layer, press [Spacebar], type 0 for distance, type 0 for angle, and press [Enter].
Polyline

Use Polyline to create single entities with multiple curved and straight edges and to modify these entities after they are drawn. Polylines help automate the construction of complex figures, and they are also useful as boundaries for other elements such as associative hatch patterns.

To draw a polyline:
1. Choose Polyline from the Polyline menu.
2. Select the first vertex of the polyline.
3. Select the next vertex of the polyline to create a straight segment between the two vertices. For a curved segment, select from the following options:
   - 2PtArc Creates an arc using two points
   - 3PtArc Creates an arc using three points
4. Continue selecting polygon vertices or choose 2PtArc, 3PtArc, or Tangent.
   - Tangent Creates arcs tangent to the last vertex you entered
5. Choose Close or Exit or right-click to end the current polyline.

To add a vertex to an existing polyline:
1. Choose AddVertx from the Polyline menu.
2. Select the polyline you want to modify.
3. Select the bulge within which you want to add a new vertex. When you select a bulge, which is an arc, the new vertex always follows the existing bulge in a counterclockwise direction, around the polyline.
4. Select the point for the new vertex.

To delete a vertex:
1. Choose DelVertx from the Polyline menu.
2. Select the polyline you want to modify.
3. Select a vertex to delete.
To move an existing vertex:
1. Choose MovVertx from the Polyline menu.
2. Choose the polyline you want to modify.
3. Select the vertex to move.
4. Select a new point for the vertex.

To straighten a curved segment:
1. Choose Blge2Vrt from the Polyline menu.
2. Select the polyline you want to modify.
3. Select a curved bulge to straighten.

To convert a straight segment into a curve:
1. Choose Vrt2Blge from the Polyline menu.
2. Select the polyline you want to modify.
3. Select a straight segment you want to curve.
4. Select a point to define a curve.

To modify a curved segment:
1. Choose EditBlge from the Polygon menu.
2. Select the polyline you want to modify.
3. Select a curved segment to modify.
4. Select a point to define a new curve.

To convert a polyline into lines and arcs:
1. Choose ExplPlin from the Polygon menu.
2. Select the polyline to explode. The polyline ungroups and explodes to lines and arcs.
To convert lines and arcs into a polyline:

1. Choose Ent2Plin from the Polyline menu.
2. Select a line or arc to include in the polyline.
3. Select another line or arc. The Cancel and AddPline options appear.
4. Continue selecting lines and/or arcs, or select one of the following options.
   - Closed: Closes the resulting polyline when on
   - Delete Entities: Erases the original entities as they are replaced by segments of the polyline; when this option is off the original entities are left after the polyline is created
   - AddPline: Completes the polyline you are creating; equivalent to right-clicking

To open or close an existing polyline:

1. Choose ToglClos from the Polyline menu.
2. Choose Closed.
3. Toggle Closed on to close open polylines. Toggle Closed off to open closed polylines.
4. Choose a polyline to modify.

The Area option calculates the area of a selected polyline, the Perim option calculates the perimeter of a selected polyline, and the Centroid option calculates the centroid of a selected polyline. With AddText you can incorporate the polyline’s area, perimeter, or centroid information into the drawing as text. AddPoint adds a center point. Area, perimeter, and centroid information is displayed in the Message Window.
Exploding Symbols

The SymExp tool explodes a drawing file’s individual instances of a symbol into its constituent entities, so you can edit them. Because the entities are no longer a symbol, they lose the attributes associated with the original symbol. Unlike the Explode toggle in the Template menu, which lets you explode a symbol only when it’s added to a drawing, SymExp lets you explode a symbol after it’s added to a drawing. Symbols are always exploded onto the active layer, regardless of which layer the symbol originated from.

➔ To explode symbols:

1. Choose SymExp from the Toolbox menu; the selection menu is displayed.

See the “Selection Menu” section in “The Drawing Board” chapter for a detailed description of selection menu options.

2. Choose the selection method you want to use.

3. Select the symbol you want to explode. The number of symbols and the number of new entities appears in the Message Window. The symbol is exploded onto the active layer.

Remember: if you choose a symbol on a layer other than the active layer, it will effectively be moved and exploded onto the active layer, leaving no instance of it on the original layer.
Form Attributes

You can use the FormAtr tool to edit attributes of entities created through a DCAL program or symbols entered in a drawing from a template. To use the form attributes tool, choose FormAtr from the Toolbox dialog box. Edit entity or symbol attributes as described below.

To modify the description or value of attributes assigned to a symbol:

1. Choose Symbols from the FormAtr menu.
2. Choose the symbol whose attributes you want to modify. That symbol’s attribute list is displayed in the Drawing Window.
3. Use Tab to cycle through the attributes to the one you want to modify.
4. Change the description or value and press Enter.
5. Press Esc.
6. Choose Yes to save the changes.

To modify the description or value of attributes assigned to an entity through a DCAL program:

1. Choose Entities from the FormAtr menu.
2. Choose the entity whose attributes you want to modify. That entities’ attribute list is displayed in the Drawing Window.
3. Use Tab to cycle through the attributes to the one you want to modify.
4. Change the description or value and press Enter.
5. Press Esc.
6. Choose Yes to save the changes.
**Line-to-Wall Conversion**

Use the line-to-wall tool to select lines and convert them to any wall type you select as well as convert any wall type to lines. This tool is useful when, for instance, you draw three lines and then want DataCAD to recognize those lines as a 3-line wall, allowing you to properly cut all three lines when you place windows and doors.

Converted lines will no longer be recognized as lines but rather as part of a wall system. When you select a line to convert it to a 3-line wall, its appearance is not changed and redrawn on screen; rather its Attrib setting is changed in the drawing’s database so that DataCAD recognizes it as part of a 3-line wall. If you use Identify in the Edit menu and select a line or a line in a 2-line wall, you’ll see in the Message Window that Attrib=5. Lines in 3-line walls have Attrib=36, and lines in 4-line walls have Attrib=63.

To convert entities:

1. Choose Lin2Wall from the Toolbox menu. The following appears:

<table>
<thead>
<tr>
<th>Selection Menu</th>
<th>Provides selection methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines</td>
<td>Converts walls you select to lines</td>
</tr>
<tr>
<td>Wall</td>
<td>Converts lines you select to 2-line walls</td>
</tr>
<tr>
<td>3LnWall</td>
<td>Converts lines you select to 3-line walls</td>
</tr>
<tr>
<td>4LnWall</td>
<td>Converts lines you select to 4-line walls</td>
</tr>
<tr>
<td>Cleanup</td>
<td>Enters the Cleanup menu; see “Cleanup” in the “Drawing and Editing” chapter for information</td>
</tr>
</tbody>
</table>

2. To convert lines to walls, choose the wall type to create (2LnWall, 3LnWall, or 4LnWall). To convert a wall system to lines, choose Lines.

3. Choose a selection method and then select the entities to convert. The lines will disappear as you select them; press [Esc] to restore the lines. You can convert only 2D lines or walls; you cannot convert curves. The entities are converted in the database.

When you use this tool to convert lines with doors or windows to wall systems, use the entity selection method to ensure that all lines are converted to wall systems.
Layer Utility

You can use the layer utility tool to recover a corrupted drawing file or to release excess memory space in a drawing file that has undergone extensive editing.

Corrupted drawing files are usually caused by power or hardware failure. When a drawing file is corrupted, information is distorted or cannot be accessed. You can use Layer Utility to recover unaffected data and help rebuild the drawing file.

Excess memory space in a drawing file is the result of extensive addition and deletion of entities and groups. The file size of a drawing is increased whenever entities or groups are added, but it is not reduced correspondingly when they are deleted. The memory space released during the delete procedure is retained by the drawing file and is made available to the system. This results in a file with potentially large amounts of unused memory. Use LyrUtil to release this memory to the rest of the system.

Using Layer Utility is a two-step process:

- Use LyrSave to save the layers from the current drawing file to a separate layer file. You can save all the layers or just selected layers.

- Create a new drawing file and use LyrLoad to load the layers from the layer file to the new drawing file. Corrupted information and excess memory are not saved or transferred to the new drawing file.

To save all layers:

1. Choose SaveAll from the LyrSave menu.
2. Choose the name of the file to save the layers to or type a layer filename at the prompt and press [Enter]. DataCAD saves the file information to the specified file.

To save selected layers:

1. Choose LyrMenu to display the Layer menu.
2. Choose On/Off to display the different drawing layers.
3. Toggle on all layers you want to save.
4. Choose Exit to return to the Layer menu.
5. Choose Exit again to return to the LyrSave menu.
6. Choose Save On to save all of the layers that are toggled on.
7. Choose or type the name of the file to save the layers to and press [Enter]. DataCAD saves the layer file. You return to the LyrUtil menu.
To create a new drawing file and then load the layers to it:

1. Return to the Edit menu. If you are in the LyrUtil menu, choose Exit twice.
2. Choose New from the File menu to create a new drawing file. You exit the
drawing on which you are currently working.
3. Choose Yes to exit the drawing.
4. Type a new name for the new file and press [Enter]. You return to the Edit menu.
5. Return to the LyrUtil tool (Edit/Toolbox/LyrUtil).
6. Choose LyrLoad.
7. Choose the name of the layer file you want to load into the new drawing file.
The layer file appears in the drawing area. You return to the LyrUtil menu.

Use DelLyrs to delete layer files. Choose any layer file from the list in the dialog box
and click Open.
Estimator Link

Use EstLink to provide information to link your drawing to the DataCAD Estimator program. You can define and extract key information about most of the materials used to construct the building you’re designing, by following easy-to-use EstLink options. Then you can compile the information in an ASCII file using Takeoff and print it or use it in other programs, such as Microsoft Excel or Lotus.

The material data extracted from your drawing is based on the areas you define and the materials you select from the material DataBase list. You don’t have to draw the actual items, such as one line to represent a tile covering on the wall and another to indicate the face of a stud wall. Estimator Link frees you from modeling each and every piece of building material required for construction. You can quickly estimate cost from your 2D production floor plan drawing.

Estimator Link extracts three major types of information from each material you assign to the building:

- **Item Name**
  A five-digit code used by the Estimator to uniquely identify each material in the material database. One example of an item name is 9.107, which uses the CSI numbering standard to identify Thermal moisture barrier (section 9.000), 1/2” Drywall Exterior Wall material. This numerical code matches your building’s material with existing material from the material database.

- **Description**
  Identifies the material. Since the item name is limited to five digits (such as 9.107), the description line is extremely valuable. For example, it would be difficult to know that 9.107 referred to drywall. However, when you define this material, the description appears: 1/2” Drywall Exterior Wall. Another description line would be 1 1/2” rigid foam insulation. For your ease-of-use, the description appears with the item name in both EstLink and in the extracted text file (the Takeoff file).

- **Quantity**
  The calculation of how much material is required for your building. This is the true link to your drawing, since you’ll use the actual areas in your design (such as a kitchen) to assign space, walls, windows, and doors. In the case of kitchen walls, for example, EstLink calculates the dimensional structure of the defined wall area and extracts that information for the Takeoff file.

Estimator Link is a material-estimation extractor and can’t provide you with true costs due to obvious reasons that affect all estimating procedures. First of all, an estimate is, by definition, an educated guess. Estimator Link can only provide you with “ballpark” figures for your cost estimating.
Another limitation is the description database. Due to the changing nature of construction materials, along with regional differences, everything required to construct your building will not appear in the Estimator Link material database. With Estimator Link, you can enter a description of new materials to accommodate these differences. Most of the materials can be automated from your drawing, however, with the remainder entered in DataCAD Estimator.

The following process explains the steps to follow to create the information Estimator Link needs and to create the Takeoff (Estimator text) file. Each option mentioned in the following steps is covered in detail later in this section.

To use Estimator Link:

1. Choose Toolbox from the Edit menu.
2. Choose EstLink from the Toolbox menu.
3. Define the boundary for material assignment by choosing either Space or Wall.
4. Identify items for material assignment using a label by choosing Window, Door, OtherLbl, or Symbol.
5. Choose Database to select the name of the material database file to use with your project.
6. Assign the materials by selecting their boundary or label name, then choosing Add Matl. Select material from the displayed options that appear with the current material database.
7. After you assign all the materials, choose Takeoff to process the key information from your drawing and compile a text file for later use in the Estimator. The Estimator uses the Takeoff file for material and cost estimates.

Add Matl and Del Matl appear on the Space, Wall, Window, Door, and OtherLbl menus once you define a boundary.

The Edit option in the EstLink menu gives you access to the 2D edit options – move, copy, rotate, stretch, enlarge, erase, and layers – without leaving Estimator Link.
Adding and Deleting Material Specifications

Use Add Matl to add material specifications to existing spaces, walls, windows, doors, and labels. You can add the material specifications as you add each boundary, or you can add the materials later. Add Matl displays a list of possible material types based on the currently selected material database, allowing you to specifically identify the correct material. If the material you need is not on the list, choose a different material database. See “Database” later in this section for more information.

When you add materials to an entity, your Icon Toolbar is temporarily turned off.

To add material specifications:

1. From the lists of spaces, walls, windows, doors, or labels, choose the item name to which to add materials.
2. Choose Add Matl. A list of material database numbers and descriptions appears. These refer to the types of materials in CSI format.
3. Choose a material from the list or type the material numbers and press Enter. For example, to define material for a space in your kitchen, assign a type of flooring. When the material you choose requires a quantity, such as Rebar in concrete work, enter the exact amount.

Once you choose the material, four space or wall measurement methods are displayed:

- **HorzArea** Extracts the measurement of a floor or ceiling space as needed for carpeting, vinyl, prep work and drywall, ceilings, etc.; the result is a square-foot calculation
- **VertArea** Measures the vertical area of a wall as needed for drywall, wallpaper, paneling, textured finishes, etc.; the Z-height of the boundary is used to calculate square-footage
- **Perimetr** Extracts the length around a boundary; this is useful for linear measurements needed for framing, molding, and interior wall treatments such as fascia or other trim
- **Volume** Determines the volume of the boundary by calculating the Z-base and Z-height settings of the boundary and applying them to the linear measurement

4. Select the type of measurement you need in the Takeoff.
5. Choose Done when you are finished defining materials.
To delete a defined material from the selected item:

1. Choose the space, window, wall, door, or label from which you want to delete a material. A list of all materials assigned to the selected space is displayed.

2. Choose Del Matl from the menu. Del Matl is displayed in the menu when you select an existing space, wall, window, door, or other label name and have defined at least one material description for the selected item.

3. Choose the name of the material to delete.

4. Choose Yes to delete the material; the material description is not deleted from the database or from any other defined material. Choose No to cancel the deletion.

Defining Space

Use Space to define a boundary around the area you’ll assign materials to, such as the boundary around the interior of the kitchen in the floor plan. Ideally, spaces are delineated by change of material requirements. In the kitchen, for example, you might define vinyl flooring, while the living room has carpeting. You would define these areas as two separate spaces.

Draw the space with either an open or closed polyline boundary, which you create as a new boundary while in Space or by selecting an existing polyline. You can also select existing 3D polygons and slabs to define your polyline boundary.

If you’re using a polyline boundary to define a wall height (vertical area) or area mass (volume), it’s important to also define the appropriate Z-base and Z-height to the boundary by pressing \[Z\]. Use Select to extract Z information from any 3D polygon or slab you select as a boundary item.

To create and name a new boundary in a drawing:

1. Choose Add Spac from the Space menu.

2. Type a name of up to eight characters to identify the space in the drawing (for example, Kitchen) and press \[Enter\].

3. To define a space using a vertical measurement, press \[Z\] to set the Z-base and Z-height for the boundary. For example, set a Z-base of 0.0 and a Z-height of 8.0. If you’re creating a floor space and only want to calculate the horizontal area, don’t worry about the Z settings.

4. Select Closed to define a closed space or boundary. For example, toggle Closed on when defining a floor space.
5. Define the boundary by selecting the corners of the room. For example, to define a kitchen space, object snap to the existing inside corners of the kitchen area.

6. When you define all the corners of your space, choose Close.

To use an existing entity for a space boundary:

1. Choose Add Spac from the Space menu.
2. Type a name of up to eight characters for the new space and press Enter.
3. Choose Select from the Add Spac menu.
4. Select the polyline, slab, or 3D polygon from your drawing that defines the boundary. You can select a polyline created with the Polyline tool or one brought in from a DXF transfer, such as a polyline from AutoCAD. You can also select 3D polygons and modeled slabs for your boundary. If you try to select another type of entity, the program ignores it. The selected entity blinks.

If you use polylines in your drawing, you can turn the display of vertex points on or off. Select 3D Edit/DCAD3D/Settings/DrwMarks to toggle the display on or off as needed. This is useful to quickly view any polylines.

To delete a defined space boundary from the drawing and its name from the list:

1. Choose Del Spac from the Space menu. A list of defined spaces appears.
2. Choose the name of the space to delete from the list.
3. Choose Yes to delete the space or No to cancel.

This does not delete entities you used for defining the space.

To identify the location of a defined space boundary in a drawing:

1. Choose ShowSpac from the Space menu. A list of defined spaces appears.
2. Choose a name from the list. The selected boundary blinks.

To rename a defined space boundary:

1. Choose NameSpac from the Space menu. A list of defined spaces appears.
2. Choose the name of the space to rename.
3. Type a new name (up to eight characters) for the selected space and press Enter.
**Defining Wall Boundaries**

Use Wall to define boundaries for your walls. As with spaces, walls are delineated by change of material requirements. For a wall that has two types of finishes, one on either side, you can draw one boundary as a single line on one side of the wall, and a second for the other side of the wall. For example, you might define a wall boundary to assign Drywall in the interior, yet assign Stone or Brick to the exterior of the same wall. If a wall requires a change of material on the same side, as in the case of drywall next to paneling, define the wall section as two separate boundary lines.

As with Space, you draw the wall with either an open or a closed polyline boundary, created as a new boundary in Wall or selected as an existing polyline, 3D polygon, or slab. You can edit this polyline with the Polyline tool, just as you would edit any polyline.

➢ To create and name a new wall boundary in a drawing:

1. Choose Add Wall from the Wall menu.
2. Type a name (up to eight characters) to identify the space in the drawing, for example, Ktchn01, and press [Enter].
3. To add a wall which will be calculated as a vertical space, press [Z] to set the Z-base and Z-height for the boundary. For example, set a Z-base of 0 and a Z-height of 8.
4. Select Closed to define a closed space or boundary. For example, toggle Closed on when defining a floor space.
5. Define the wall boundary by selecting the corners of the wall to define. For example, you may be defining an 8’-0” kitchen wall. Object snap to the inside corners of the existing wall in the kitchen area.
6. When you finish defining walls, choose Closed.

➢ To select an existing entity for a wall boundary:

1. Choose Add Wall from the Wall menu.
2. Type a name of up to eight characters for the new wall and press [Enter].
3. Choose Select from the Add Wall menu.
4. Select the polyline, slab, or 3D polygon from your drawing that defines the space. You can select a polyline created with the Polyline tool or one brought in from a DXF transfer, such as a polyline from AutoCAD. You can also select 3D polygons and modeled slabs for your boundary. If you try to select another type of entity, the program ignores it. The selected entity blinks.
To delete a defined wall boundary from the drawing and its name from the list:
1. Choose Del Wall from the Wall menu. A list of defined walls appears.
2. Choose a wall name to delete from the list.
3. Choose Yes to delete the wall or No to cancel.
The original floor plan wall will not be deleted.

To locate a defined wall boundary in a drawing:
1. Choose ShowWall from the Wall menu. A list of defined walls appears.
2. Choose a wall name to show. The selected boundary blinks.

To rename a defined wall boundary:
1. Choose NameWall from the Wall menu. A list of defined walls appears.
2. Choose the wall name to rename.
3. Type a new name (up to eight characters) for the selected space and press [Enter].

Adding Labels
Use Window, Door, and OtherLbl in the EstLink menu to define labels for windows and doors as well as other items, such as special equipment. These menus provide you with options concerning the text and the container (the bubble that surrounds text).

Use Add Wndw, Add Door, and Add Labl to define new labels. You don’t have to draw the window, door, or object. Instead you can define the essential information in a label. You can use one label on many objects when they are the same type and size. The database counts each instance of duplicate labels as a separate item. See the instructions for reusing labels later in this section for more information.

To add a label:
1. Choose Add Wndw from the Window menu, Add Door from the Door menu, or Add Labl from the OtherLbl menu.
2. Type a name (up to eight characters) for the window, door, or object and press [Enter]. A list of shape and text options is displayed.
3. To change the label text font, choose Font from the menu, and then choose a font style from the list and press [Enter].
4. To set the size of label text, choose TextSize from the menu, and then choose a new text size from the list, or type a value and press [Enter].
5. To set the line angle for label text, choose Angle from the menu, and then choose a new angle from the list, or type a value and press \texttt{Enter}.

6. To define the angular offset (from vertical) of label text, choose Slant from the menu, and then choose a new slant from the list, or type a value and press \texttt{Enter}.

For example, a value of 15 changes the text to italics, while a value of -15 back slants the text.

7. To set the height/width ratio of text, choose Aspect from the menu, and then choose a new aspect ratio from the list, or type a value and press \texttt{Enter}.

This controls the appearance of text width. For a value of 1.5, the text appears thin. For a value of .5, the text appears wider and more spread out.

8. Use Shape to define the shape of the text container. (The container sizes are adjusted using ShpRatio.) When you choose Shape from the menu, you can choose from the following container shape options:

- **None**: Turns off the container that appears with the label text
- **Circle**: Surrounds the text with a circle
- **Rectangl**: Surrounds the text with a rectangle
- **Square**: Surrounds the text with a square
- **Capsule**: Surrounds the text with a round-cornered rectangle
- **Ellipse**: Surrounds the text with an elliptical shape
- **Polygon**: Surrounds the text with a user-definable polygon; a prompt appears asking you to enter the number of sides and how to draw the polygon
- **No Sides**: Choose the number of sides for a polygon label when Polygon is on
- **FlatBtm**: Choose a flat or round label bottom when Polygon is on
- **Underline**: Underlines the label text

9. Use ShpRatio to adjust the size of the container for the text label. The size is calculated in relationship to the text size or length. For example, the diameter of a circle is calculated by the length of the text line it must surround. When the shape ratio is set to 1.0, the sides of the circle touch the ends of the text line. When the shape ratio is set to 1.5, the distance between the ends of the text line and the circle diameter are half the current text size. To adjust the shape ratio, choose ShpRatio from the menu, and then choose a shape ratio from the list, or type a value and press \texttt{Enter}.

10. Select a position for the window.

To change color for text and labels, press \texttt{k} too quickly cycle through available colors.
To delete the name of a defined window, door, or other object and its label:

1. Choose Del Wndw from the Window menu, Del Door from the Door menu, or Del Labl from the OtherLbl menu. A list of defined items is displayed.
2. Choose a name to delete from the list.
3. Choose Yes to delete the object or No to cancel.

To locate a label in a drawing:

1. Choose ShowWndw from the Window menu, ShowDoor from the Door menu, or ShowLabl from the OtherLbl menu. A list of defined items is displayed.
2. Choose a name to show. The label blinks.

You can reuse a label name for more than one window, door, or other object. For example, if you have five windows that are exactly the same, you can use the same label for all five windows. When the material Takeoff is extracted, each label is counted, and the final quantity for that object type is counted. You can also create one label and input the material quantity as 5. With this example of five windows, in the final drawing one window would have a label and the other four wouldn’t.

To reuse a label:

1. Choose Use Wndw from the Window menu, Use Door from the Door menu, or Use Labl from the OtherLbl menu. A list of defined items appears.
2. Choose the item from the list.
3. Indicate the position for the new window, door, or object.
4. Choose Exit when you finish placing objects.

Assigning Materials to Symbols

Use Symbol to assign materials to items in your drawing that may already have a label, such as door or window schedule bubbles. In order to use these labels, they must be a symbol.

To delete the name of a defined symbol as well as the symbol itself:

1. Choose Del Symb from the Symbol menu. A list of defined symbols is displayed.
2. Choose the name of the symbol to delete.
3. Choose Yes to delete the symbol or No to cancel.
To locate a symbol in a drawing:
1. Choose ShowSymb from the Symbol menu. A list of defined symbols is displayed.
2. Choose a symbol name to show. The label blinks.

To rename an existing symbol:
1. Choose NameSymb from the Symbol menu. A list of defined symbols is displayed.
2. Choose the name of the symbol to rename.
3. Type a new name (up to eight characters) for the selected symbol and press Enter.

Use Symb to reuse a symbol name for more than one entity. For example, if you have five entities that are exactly the same, you can use the same label for all five entities. When the material Takeoff is extracted, each label is counted and the final quantity for that entity type is counted. You can also create one label and input the material quantity as 5.

To reuse a symbol name:
1. Choose Use Symb from the Symbol menu. A list of defined symbols is displayed.
2. Choose the symbol from the list.
3. Indicate the position for the new symbol.
4. Choose Exit when you finish placing symbols.
Extracting Material Information

Use Takeoff to extract the data, calculate areas and measurements, and create a text file after the material information has been defined. A line appears in the text file for each material assigned.

The text file created by Takeoff is in the following format:

/900, measurement/count, SF/EA, item tag number, description, area name

- A forward slash and number allowing the Estimator to perform cost calculations. (/900 in the first example below)
- A square-foot or linear measurement (as in length and height of walls) or a count (as in quantity of doors). (204.8 in the first example below)
- A designator indicating whether the measurement is in square-footage, SF, or exact count, EA. (SF in the first example below)
- A five digit item name in the database. (9.705 in the first example below)
- A description. (FLOOR-VINYL SHEET in the first example below)
- A name you gave the area (space, wall, window, door, or label) when you defined it. (kitchen in the first example below)

An example of three different materials for the kitchen area:

/900,204.8,SF, 9.705,FLOOR-VINYL SHEET,kitchen
/900,1.0,EA, 8.003,DOOR-EXT 2-8x6-8 S/C H/B,kitchen
/900,204.8,SF, 7.273,1-1/2” RIGID FOAM,kitchen

To create a takeoff of materials:

1. Choose Takeoff from the EstLink menu when you are ready to create a text file to use with Estimator or your estimating software.
2. Choose Yes to create a takeoff; choose No to return to the EstLink menu.
3. Type a directory, path, and filename for the material Takeoff file, then press [Enter]. EstLink automatically assigns a file extension of .CSV to the Takeoff file.
4. Choose Exit to return to the EstLink menu.
Selecting Material Databases

Use Database to select a new material database for material lists or to update the drawing material database with new material definitions.

Use Select in the Database menu to choose a new material database to use with your material assignment using Add Matl. The default pathname for the database is `\DATACAD\DCX\`.

Use Reload in the Database menu to update the drawing file’s material list to match a material in another, predefined material database. Helpful if you modified a database using Estimator and want to use that database in your current file. Open the drawing containing the database with the predefined material. Select that database as your current database. Then use Reload to update the drawing’s material list to match the modified database.